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Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your safety and 

benefit, read this manual carefully before using the machine. Keep this manual in a handy place for quick reference.

Do not copy or print any item for which reproduction is prohibited by law.

Copying or printing the following items is generally prohibited by local law:

bank notes, revenue stamps, bonds, stock certificates, bank drafts, checks, passports, driver's licenses.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be liable for direct, 

indirect, special, incidental, or consequential damages as a result of handling or operating the machine.

Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

Notes

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.

Depending on which country you are in, your machine may include certain options as standard. For details, please 

contact your local dealer.



Manuals for This Machine
Refer to the manuals that are relevant to what you want to do with the machine.

• Media differ according to manual.

• The printed and electronic versions of a manual have the same contents.

• Adobe® Acrobat® Reader®/Adobe Reader must be installed in order to view the manuals as PDF
files.

• A Web browser must be installed in order to view the html manuals.

• For details about the functions of RW-7140, refer to the manuals for this option.

About This Machine

Be sure to read the Safety Information in this manual before using the machine.

This manual provides an introduction to the functions of the machine. It also explains the control
panel, preparation procedures for using the machine, how to enter text, and how to install the CD-
ROMs provided.

Troubleshooting

Provides a guide to solving common problems, and explains how to replace paper, toner, and
other consumables.

Copy/Document Server Reference

Explains Copier and Document Server functions and operations. Also refer to this manual for
explanations on how to place originals.

Printer Reference

Explains Printer functions and operations.

Scanner Reference

Explains Scanner functions and operations.

Network Guide

Explains how to configure and operate the machine in a network environment, and use the
software provided.

General Settings Guide

Explains User Tools settings, and Address Book procedures such as registering e-mail addresses,
and user codes. Also refer to this manual for explanations on how to connect the machine.

Security Reference

This manual is for administrators of the machine. It explains security functions that you can use to
prevent unauthorized use of the machine, data tampering, or information leakage. For enhanced
security, we recommend that you first make the following settings:
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• Install the Device Certificate.

• Enable SSL (Secure Sockets Layer) Encryption.

• Change the user name and password of the administrator using Web Image Monitor.

For details, see "Setting Up the Machine", Security Reference.

Be sure to read this manual when setting the enhanced security functions, or user and administrator
authentication.

PostScript 3 Supplement

Explains how to set up and use PostScript® 3TM.

UNIX Supplement

For "UNIX Supplement", please visit our Web site or consult an authorized dealer.

This manual includes descriptions of functions and settings that might not be available on this
machine.

Information

Contains general notes on the machine, and information about the trademarks of product names
used in the manuals.

Other manuals

• Manuals for DeskTopBinder Lite

• DeskTopBinder Lite Setup Guide

• DeskTopBinder Introduction Guide

• Auto Document Link Guide

• Manuals provided are specific to machine types.

• The following software products are referred to using general names:

Product name General name

DeskTopBinder Lite and DeskTopBinder
Professional*1 DeskTopBinder

ScanRouter EX Professional*1 and ScanRouter

EX Enterprise*1
the ScanRouter delivery software

*1 Option
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How to Read This Manual

Symbols

This manual uses the following symbols:

Indicates points to pay attention to when using the machine, and explanations of likely causes of paper
misfeeds, damage to originals, or loss of data. Be sure to read these explanations.

Indicates supplementary explanations of the machine’s functions, and instructions on resolving user
errors.

This symbol is located at the end of sections. It indicates where you can find further relevant information.

[ ]
Indicates the names of keys on the machine's display or control panels.

About IP Address

In this manual, “IP address” covers both IPv4 and IPv6 environments. Read the instructions that are
relevant to the environment you are using.
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1. Using a Printer Server

Preparing Printer Server
This section explains how to configure the machine as a Windows network printer. The machine is
configured to enabling network clients to use it. When the network printer is connected via
SmartDeviceMonitor for Client, you can set the printing notification function to notify clients of the results
of their print jobs.

• Under Windows XP Professional or Windows Server 2003/2003 R2, to change printer properties
in the [Printer] folder, you need Printer Management access authentication; under Windows Vista,
Full Control access authentication. Log on to the file server as an Administrator or member of the
PowerUsers group.

1. Open the [Printers and Faxes] window from the [Start] menu.

The [Printers and Faxes] window appears.

2. Click the icon of the machine you want to use. On the [File] menu, click [Properties]. The
printer properties appear.

3. On the [Sharing] tab, click [Share this printer].

4. To share the machine with users using a different version of Windows, click [Additional
Drivers...].

If you have installed an alternative driver by selecting [Share As:] during the printer driver
installation, this step can be ignored.

5. Click [OK], and then close the printer properties.

Printing notification via SmartDeviceMonitor for Client

Follow the procedure below to configure the machine to use the printing notification function of
SmartDeviceMonitor for Client.

Setting the print server

• Under Windows XP Professional or Windows Server 2003/2003 R2, to change printer properties
in the [Printer] folder, you need Printer Management access authentication; under Windows Vista,
Full Control access authentication. Log on to the file server as an Administrator or member of the
PowerUsers group.
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1. On the [Start] menu, point to [All Programs], [DeskTopBinder], [SmartDeviceMonitor for
Client], and then click [Print Server Setting].

The print server setting dialog box appears.

2. Select the [Notify client PCs of printout/data-transmission] check box, and then click
[OK].

After print server setting is made, a dialog box appears. Confirm the dialog box content, and click
[OK].

Click [Cancel] to interrupt the procedure.

A dialog box appears for client setting.

3. Click [OK].

The print server setting is completed. Each client must be set to receive print notification.

• Current printing jobs restart from the beginning after the spooler pauses briefly.

• When the expansion function is not used, the function is automatically set as available.

• If you log on using an account that does not have Administrator privileges, the client may not
be notified.

• For details, see “Using the SmartDeviceMonitor for Client Port”, Printer Reference.

Setting a Client

1. On the [Start] menu, point to [All Programs], [DeskTopBinder], [SmartDeviceMonitor for
Client], and then click [Extended Features Settings].

A dialog box for setting the expansion function appears.

2. Select the [Notify of printout/data-transmission when using print server] check box.

3. Click [OK].

The client setting is completed.

• Set the printing notification function on the printer driver as well as on SmartDeviceMonitor for
Client.

1. Using a Printer Server
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Using NetWare
This section describes the setting procedure for network printers in the NetWare environment. In the
NetWare environment, you can connect the machine as a "print server" or "remote printer".

• IPv6 cannnot be used on this function.

Setting procedure

• When using the machine as a print server

1. Installing SmartDeviceMonitor for Admin

2. Setting the network interface board.

3. Turning the machine off and then back on.

• When using the machine as a remote printer

1. Installing SmartDeviceMonitor for Admin.

2. Setting the network interface board.

3. Setting NetWare.

4. Starting the print server.

• This procedure assumes an environment is already prepared for normal NetWare
running the printing service setting.

• The procedure is explained with the following example settings:

• File server's name ...CAREE

• Print server's name ...PSERV

• Printer's name ...R-PRN

• Queue name ...R-QUEUE

Using SmartDeviceMonitor for Admin

To use the machine in a NetWare environment, use SmartDeviceMonitor for Admin to set the
NetWare printing environment.

Printers listed by SmartDeviceMonitor for Admin

SmartDeviceMonitor for Admin lists printers connected to the network. If you cannot identify the
machine you want to configure, print configuration page, and then check the machine name.

• The NetWare Client provided by Novell is required to set the printing environment using
SmartDeviceMonitor for Admin under the following environments:

• NDS or Bindery mode in Windows 2000/XP

Using NetWare
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• For details about SmartDeviceMonitor for Admin, see "Installing SmartDeviceMonitor for Admin".

• p.35 "Installing SmartDeviceMonitor for Admin"

Setting Up as a Print Server (NetWare 3.x)

Follow the procedure below to connect the machine as a print server using NetWare 3.x.

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and password appears.

3. Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network administrator.

4. Click [Configuration] in the left area, and then click [NetWare Print Settings].

• Print Server Name: Enter the NetWare print server name. To use the interface board as a print
server, enter the name of a print server that is not active on the file server. Use up to 47
characters.

• Logon Mode: Specify whether to designate a file server or NDS tree when logging on to
NetWare.

• File Server Name: When a file server name is entered here, only the specified file server is
searched for. This item is mandatory. Use up to 47 characters.

• NDS Tree: To enable NDS mode, enter the name of the NDS tree you want to log on to. Use
up to 32 alphanumeric characters.

• NDS Context Name: To enable NDS mode, enter the print server context. Use up to 127
characters.

• Operation Mode: Specify whether to use the interface board as a print server or a remote
printer.

• Remote Printer No.: This item is effective when the interface board is specified as a remote
printer. Enter the same number as the number of the printer to be created on the print server (0
to 254 characters).

• Job Timeout: When the interface board is used as a NetWare remote printer, the printer
cannot detect when a print job ends. Therefore, the printer terminates printing when a certain
period of time has elapsed since it last received print data (i.e., when it has not received print
data for a certain period of time). Specify here this period of time (3 to 255 seconds). The
initial value is 15 (seconds).

• Frame Type: Select the frame type from the drop-down menu.

• Print Server Protocol: Select the protocol for NetWare from the drop-down menu.

1. Using a Printer Server
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• NCP Delivery Protocol: Select the protocol for NCP delivery.

5. Confirm the settings, and then click [Device Name].

Configuration is now complete. Wait several before restarting Web Image Monitor.

6. Click [Logout].

• To check the configuration is correct, enter the following from the command prompt:

F:> USERLIST

• If the printer works as configured, the name of the print server appears as a connected user.

• If you cannot identify the printer you want to configure, check the printer name against the
configuration page printed from the printer. For details about printing a configuration page, see
"Printing the Configuration Page", General Settings Guide.

• If no printer names appear in the list, match the frame types of IPX/SPXs for the computer and
printer. Use the [Network] dialog box of Windows to change the frame type of the computer.

• For details about Web Image Monitor, see "Using Web Image Monitor".

• For details about login user names and passwords, see Security Reference, which is the
administrator's manual.

• p.21 "Using Web Image Monitor"

Setting Up as a Print Server (NetWare 4.x, 5 / 5.1, 6 / 6.5)

Follow the procedure below to connect the machine as a print server using NetWare 4.x, NetWare 5 /
5.1, or NetWare 6 / 6.5.

• When using the printer as a print server in NetWare 4.x, NetWare 5 / 5.1, or NetWare 6 / 6.5,
set it to the NDS mode.

• When using NetWare 5 / 5.1 or NetWare 6 / 6.5, set the printer as a print server.

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and password appears.

3. Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network administrator.

4. Click [Configuration] in the left area, and then click [NetWare Print Settings].

Using NetWare
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5. Confirm the settings, and then click [Device Name].

Configuration is now complete. Wait several minutes before restarting Web Image Monitor.

6. Click [Logout].

7. Quit Web Image Monitor.

• To check the configuration is correct, enter the following from the command prompt:

F:> USERLIST

• If the printer works as configured, the name of the print server appears as a connected user.

• If you cannot identify the printer you want to configure, check the printer name against the
configuration page printed from the printer. For details about printing a configuration page, see
"Printing the Configuration Page", General Settings Guide.

• If no printer names appear in the list, match the frame types of IPX/SPXs for the computer and
printer. Use the [Network] dialog box of Windows to change the frame type of the computer.

• For details about Web Image Monitor, see "Using Web Image Monitor".

• For details about login user names and passwords, see Security Reference, which is the
administrator's manual.

• p.21 "Using Web Image Monitor"

Using Pure IP in the NetWare 5 / 5.1 or 6 / 6.5 Environment

Follow the procedure below to connect the machine as a print server in a pure IP environment of
NetWare 5 / 5.1 or NetWare 6 / 6.5.

• When creating a queued print server in a pure IP environment of NetWare 5 / 5.1 or NetWare
6 / 6.5, create a print queue on the file server using NetWare Administrator.

• This printer is not available as a remote printer for use in a pure IP environment.

• To use the printer in a pure IP environment, set it to IPv4.

Setting up using NWadmin

1. From Windows, start NWadmin.

For details about NWadmin, see the NetWare manuals.

2. Select the object in which the print queue is located in the directory tree, and then click
[Create] on the [Object] menu.

3. In the [Class of new object] box, click [Print Queue], and then click [OK].

1. Using a Printer Server

14



4. In the [Print Queue Name] box, enter the name of the print queue.

5. In the [Print Queue Volume] box, click [Browse].

6. In the [Available objects] box, click the volume in which the print queue is created, and
then click [OK].

7. Check the settings, and then click [Create].

8. Select the object in which the printer is located, and then click [Create] on the [Object]
menu.

9. In the [Class of new object] box, click [Printer], and then click [OK]. For NetWare 5, click
[Printer (Non NDPS)].

10. In the [Printer name] box, enter the printer name.

11. Select the [Define additional properties] check box, and then click [Create].

12. Click [Assignments], and then click [Add] in the [Assignments] area.

13. In the [Available objects] box, click the queue you created, and then click [OK].

14. Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

15. Click [Manual load] in the [Communication type] area, and then click [OK].

16. Check the settings, and then click [OK].

17. Select a context specified, and then click [Create] on the [Object] menu.

18. In the [Class of new object] box, click [Print Server], and then click [OK]. For NetWare 5,
click [Print Sever (Non NDPS)].

19. In the [Print Server Name] box, enter the print server name.

Use the same print server name specified using SmartDeviceMonitor for Admin.

20. Select the [Define additional properties] check box, and then click [Create].

21. Click [Assignments], and then click [Add] in the [Assignments] area.

22. In the [Available objects] box, click the queue you created, and then click [OK].

23. Check the settings, and then click [OK].

24. Start the print server by entering the following from the console of the NetWare server.

If the print server is in operation, quit and restart it.

To quit

CAREE: unload pserver

To start

CAREE: load pserver print_server_name

Setting up using Web Image Monitor

1. Start Web Image Monitor.

Using NetWare
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2. Click [Login].

A dialog box for entering the login user name and login password appears.

3. Enter the user login user name and password, and then click [Login].

For details about the login name and password, consult your network administrator.

4. Click [Configuration] in the left area, and then click [NetWare Print Settings].

5. Confirm the settings, and then click [Device Name].

Configuration is now complete. Wait several minutes before restarting Web Image Monitor.

6. Click [Logout].

7. Quit Web Image Monitor.

• If you cannot identify the printer you want to configure, check the printer name against the
configuration page printed from the printer. For details about printing a configuration page, see
"Printing the Configuration Page", General Settings Guide.

• If no printer names appear in the list, match the frame types of IPX/SPXs for the computer and
printer. Use the [Network] dialog box of Windows to change the frame type of the computer.

• For details about Web Image Monitor, see "Using Web Image Monitor".

• For details about login user names and passwords, see Security Reference, which is the
administrator's manual.

• p.21 "Using Web Image Monitor"

Setting Up as a Remote Printer (NetWare 3.x)

Follow the procedure below to use the machine as a remote printer under NetWare 3.x.

Setting up using PCONSOLE

1. Enter "PCONSOLE" from the command prompt.

F:> PCONSOLE

2. Create a print queue.

When using the existing print queue, go to the procedure for creating a printer.

3. From the [Available Options] menu, select [Print Queue Information], and then press the
[Enter] key.

4. Press [Insert] key, and then enter a print queue name.

5. Press [Esc] key to return to the [Available Options] menu.

6. Set up the network connection to a printer.

1. Using a Printer Server
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7. On the [Available Options] menu, click [Print Server Information], and then press the
[Enter] key.

8. To create a new print server, press the [Insert] key, and then enter a print server name.

For a currently defined print server, select a print server in the [Print Server] list.

Use the same printer name specified using SmartDeviceMonitor for Admin.

9. From the [Print Server Information] menu, select [Print Server Configuration].

10. From the [Print Server Configuration] menu, select [Printer Configuration].

11. Select the printer indicated as [Not Installed].

Use the same printer number specified as the remote printer number using SmartDeviceMonitor for
Admin.

12. To change the printer name, enter a new name.

A name "printer x" is assigned to the printer. The "x" stands for the number of the selected printer.

13. As type, select [Remote Parallel, LPT1].

The IRQ, Buffer size, Starting form, and Queue service mode are automatically configured.

14. Press the [Esc] key, and then click [Yes] on the confirmation message.

15. Press the [Esc] key to return to [Print Server Configuration Menu].

16. Assign print queues to the created printer.

17. From [Print Server Configuration Menu], select [Queues Serviced By Printer].

18. Select the printer created.

19. Press the [Insert] key to select a queue serviced by the printer.

You can select several queues.

20. Follow the instructions on the screen to make other necessary settings.

Following these steps, check that the queues are assigned.

21. Press the [Esc] key until "Exit?" appears, and then select [Yes] to exit PCONSOLE.

22. Start the print server by entering the following from the console of the NetWare server.

If the print server is in operation, quit and restart it.

To quit

CAREE: unload pserver

To start

CAREE: load pserver print_server_name

If the printer works as configured, the message "Waiting for job" appears.

Setting up using Web Image Monitor

1. Start Web Image Monitor.

Using NetWare

17



2. Click [Login].

A dialog box for entering the login user name and login password appears.

3. Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network administrator.

4. Click [Configuration] in the left area, and then click [NetWare Print Settings].

5. Confirm the settings, and then click [Device Name].

Configuration is now complete. Wait several minutes before restarting Web Image Monitor.

6. Click [Logout].

7. Quit Web Image Monitor.

• If you cannot identify the printer you want to configure, check the printer name against the
configuration page printed from the printer. For details about printing a configuration page, see
"Printing the Configuration Page", General Settings Guide.

• If no printer names appear in the list, match the frame types of IPX/SPXs for the computer and
printer. Use the [Network] dialog box of Windows to change the frame type of the computer.

• For details about Web Image Monitor, see "Using Web Image Monitor".

• For details about login user names and passwords, see Security Reference, which is the
administrator's manual.

• p.21 "Using Web Image Monitor"

Setting Up as a Remote Printer (NetWare 4.x, 5 / 5.1, 6 / 6.5)

Follow the procedure below to use the printer as a remote printer under NetWare 4.x, 5 / 5.1 and 6 /
6.5.

• To use the printer as a remote printer under NetWare 4.x, 5 / 5.1, 6 / 6.5, set it to NDS mode.

• Do not use the printer as a remote printer when Pure IP is used.

Setting up using NWadmin

1. From Windows, start NWadmin.

For details about NWadmin, see the NetWare manuals.

2. Set up the network connection to a print queue. Select the object in which the print queue
is located in the directory tree, and then click [Create] on the [Object] menu.

3. In the [Class of new object] box, click [Print Queue], and then click [OK].

1. Using a Printer Server
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4. In the [Print Queue Name] box, enter the name of the print queue.

5. In the [Print Queue Volume] box, click [Browse].

6. In the [Available objects] box, click the volume in which the print queue is created, and
then click [OK].

7. Check the settings, and then click [Create].

8. Set up the network connection to a printer. Select the object in which the printer is located,
and then click [Create] on the [Object] menu.

9. In the [Class of new object] box, click [Printer], and then click [OK]. For NetWare 5, click
[Printer (Non NDPS)].

10. In the [Printer name] box, enter the printer name

11. Select the [Define additional properties] check box, and then click [Create].

12. Assign print queues to the created printer. Click [Assignments, and then click [Add] in the
[Assignments] area.

13. In the [Available objects] box, click the queue you created, and then click [OK].

14. Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

15. Click [Manual load] in the [Communication type] area, and then click [OK]. Check the
settings, and then click [OK].

16. Set up the network connection to a print server. Select a context specified, and then click
[Create] on the [Object] menu.

17. In the [Class of new object] box, click [Print Server], and then click [OK]. For NetWare 5,
click [Print Sever (Non NDPS)].

18. In the [Print Server Name:] box, enter the print server name.

Use the same print server name specified using SmartDeviceMonitor for Admin.

19. Select the [Define additional properties] check box, and then click [Create].

20. Assign the printer to the created print server. Click [Assignments], and then click [Add] in
the [Assignments] area.

21. In the [Available objects] box, click the queue you created, and then click [OK].

22. In the [Printers] area, click the printer you assigned, and then click [Printer Number].

23. Enter the printer number, and then click [OK]. Check the settings, and then click [OK].

Use the same printer number specified as the remote printer number using SmartDeviceMonitor for
Admin.

24. Start the print server by entering the following from the console of the NetWare server.

If the print server is in operation, quit and restart it.

To exit

CAREE: unload pserver

Using NetWare
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To start

CAREE: load pserver print_server_name

25. Enter the printer server name as the context name, and then press the [Enter] key.

26. Select the printer name on the context menu, and then press the [Enter] key.

Setting up using Web Image Monitor

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and login password appears.

3. Enter the user login name and password, and then click [Login].

For details about the login user name and password, consult your network administrator.

4. Click [Configuration] in the left area, and then click [NetWare Print Settings].

5. Confirm the settings, and then click [Device Name].

Configuration is now complete. Wait several minutes before restarting Web Image Monitor.

6. Click [Logout].

7. Quit Web Image Monitor.

• If you cannot identify the printer you want to configure, check the printer name against the
configuration page printed from the printer. For details about printing a configuration page, see
"Printing the Configuration Page", General Settings Guide.

• If no printer names appear in the list, match the frame types of IPX/SPXs for the computer and
printer. Use the [Network] dialog box of Windows to change the frame type of the computer.

• For details about Web Image Monitor, see "Using Web Image Monitor".

• For details about login user names and passwords, see Security Reference, which is the
administrator's manual.

• p.21 "Using Web Image Monitor"
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2. Monitoring and Configuring the
Printer

Using Web Image Monitor
Using Web Image Monitor, you can check the machine status and change settings.

Available operations

The following operations can be remotely performed using Web Image Monitor from a client
computer.

• Displaying machine status or settings

• Checking the print job status or history

• Checking, modifying, printing, or deleting print jobs stored in the Document Server

• Interrupting currently printing jobs

• Resetting the machine

• Managing the Address Book

• Making machine settings

• Making network protocol settings

• Making security settings

Configuring the machine

To perform the operations from Web Image Monitor, TCP/IP is required. After the machine is
configured to use TCP/IP, operations from Web Image Monitor become available.

Recommended Web browser

• Windows:

Internet Explorer 5.5 SP2 or higher

Firefox 1.0 or higher

• Mac OS:

Firefox 1.0 or higher

Safari 1.0, 1.2, 2.0 (412.2) or higher

Web Image Monitor supports screen reader software. We recommend JAWS 7.0 or a later
version.

• Safari cannot be used on Mac OS X 10.4.1.
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• Display and operation problems can occur if you do not enable JavaScript and cookies, or if you
are using a non-recommended Web Browser.

• If you are using a proxy server, change the Web browser settings. Contact your administrator for
information about the settings.

• Machine information is not automatically updated. To perform an update, click [Refresh] in the
display area.

• We recommend using Web Image Monitor in the same network.

• You cannot access to the machine from outside the firewall.

• When using the machine under DHCP, the IP address may be automatically changed by the DHCP
server settings. Enable DDNS setting on the machine, and then connect using the machine's host
name. Alternatively, set a static IP address to the DHCP server.

• If the HTTP port is disabled, connection to the machine using the machine's URL cannot be
established. SSL setting must be enabled on this machine. For details, consult your network
administrator.

• When using the SSL encryption protocol, enter "https://(machine's IP address or host name)/".

• Internet Explorer must be installed on your computer. Use the most recent available version. We
recommend Internet Explorer 6.0 or later.

• When you are using Firefox, fonts and colors may be different, or tables may be out of shape.

• When using a host name under Windows Server 2003 with IPv6 protocol, perform host name
resolution using an external DNS server. The host file cannot be used.

• To use JAWS 7.0 under Web Image Monitor, you must be running Windows OS and Microsoft
Internet Explorer 5.5 SP2, or a later version.

Displaying Top Page

This section explains the Top Page and how to display Web Image Monitor.

• When entering an IPv4 address, do not begin segments with zeros. For example: If the address is
"192.168.001.010", you must enter it as "192.168.1.10".

1. Start your Web browser.

2. Enter "http://(machine's IP address or host name)/" in your Web browser's URL bar.

Top Page of Web Image Monitor appears.

If the machine's host name has been registered on the DNS or WINS server, you can enter it.

When setting SSL, a protocol for encrypted communication, under environment which server
authentication is issued, enter "https://(machine's IP address or host name)/".

Every Web Image Monitor page is divided into the following areas:

2. Monitoring and Configuring the Printer
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BLX300S

1. Menu area

If you select menu, it's content will be shown on the work area, or the sub area.

2. Tab area

Details about each menu appears.

3. Header area

The dialog box for switching to the user mode and administrator mode appears, and each mode's menu will
be displayed.

The link to help and dialog box for keyword search appears.

4. Help

Use Help to view or download Help file contents.

5. Display area

Displays the contents of the item selected in the menu area.

Machine information in the display area is not automatically updated. Click [Refresh] at the upper right in the
display area to update the machine information. Click the Web browser's [Refresh] button to refresh the entire
browser screen.

• When using a host name under Windows Server 2003 or Windows Vista with IPv6 protocol, perform
host name resolution using an external DNS server. The host file cannot be used.

When User Authentication is Set

Login (using Web Image Monitor)

Follow the procedure below to log on when user authentication is set.

Using Web Image Monitor
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1. Click [Login].

2. Enter a login user name and password, and then click [Login].

For details about the login user name and password, consult your network administrator.

• For user code authentication, enter a user code in [Login User Name], and then click [Login].

• The procedure may differ depending on the Web browser used.

Log Off (using Web Image Monitor)

Click [Logout] to log off.

• When you log on and made the setting, always click [Logout].

About Menu and Mode

There are two modes available with Web Image Monitor: guest mode and administrator mode.

Displayed Items may differ depending on the machine type.

About Guest Mode

In the guest mode, machine status, settings, and print job status can be viewed, but the machine
settings cannot be changed.

BLX301S

1. Home

The [Status], [Device Info], [Counter], and [Inquiry] tab are displayed. Details of the tab menu are displayed
on the work area.

2. Monitoring and Configuring the Printer
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2. Document Server

Display files stored in the Document Server.

3. Printer: Print Jobs

Allows you to display list of Sample Print, Locked Print, Hold Print, and Stored Print jobs.

4. Job

Display all print files.

5. Configuration

Display current machine and network settings.

Administrator Mode

In the administrator mode, you can configure various machine settings.

BLX302S

1. Home

The [Status], [Device Info], [Counter], and [Inquiry] tab are displayed. Details of the tab menu are displayed
on the work area.

2. Document Server

Display files stored in the Document Server.

3. Printer: Print Jobs

Allows you to display list of Locked Print, Sample Print, Hold Print, and Stored Print jobs.

4. Job

Display all print files.

5. Address Book

User information can be registered, displayed, changed, and deleted.

6. Configuration

Make system settings for the machine, interface settings, and security.

Using Web Image Monitor
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7. Reset Device

Click to reset the printer. If a print job is being processed, the printer will be reset after the print job is
completed. This button is located on Top Page.

8. Reset Printer Job

Click to reset current print jobs and print jobs in queue. This button is located on Top Page.

Access in the Administrator Mode

Follow the procedure below to access Web Image Monitor in the administrator mode.

1. On Top Page, click [Login].

The window for entering the login user name and password appears.

2. Enter your login user name and password, and then click [Login].

For details about the login user name and password, consult your network administrator.

List of Setting Items

The following tables show Web Image Monitor items that can be viewed or modified depending on the
selected mode on the Web browser. Select one of the following modes to log on Web Image Monitor:

• Guest mode: logged on as a user

• Administrator mode: logged on as an administrator

Home

Status

Menu Guest mode Administrator mode

Reset Device None Modify

Reset Printer Job None Modify

Status Read Read

Toner Read Read

Input Tray Read Read

Output Tray Read Read

Device Info

2. Monitoring and Configuring the Printer
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Menu Guest mode Administrator mode

Functions Read Read

System Read Read

Version Read Read

Printer Language Read Read

Counter

Menu Guest mode Administrator mode

Copier Read Read

Printer Read Read

Send/TX Total Read Read

Scanner Send Read Read

Inquiry

Menu Guest mode Administrator mode

Machine Maintenance/
Repair

Read Read

Sales Representative Read Read

Document Server

Document Server

Guest mode Administrator mode

Read/Modify Read/Modify

Printer: Print Jobs

Print Job List

Guest mode Administrator mode

Read/Modify Read/Modify

Using Web Image Monitor
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Job

Job List

Menu Guest mode Administrator mode

Current/Waiting Jobs Read Read/Modify

Job History Read Read

Printer

Menu Guest mode Administrator mode

Spool Printing Read Read/Modify

Job History Read Read

Error Log Read Read

Document Server

Menu Guest mode Administrator mode

Print Job History Read/Modify Read/Modify

Scanner Remote Send History Read/Modify Read/Modify

Address Book

Menu Guest mode Administrator mode

Address Book None Read/Modify

Configuration

Device Settings

Menu Guest mode Administrator mode

System Read Read/Modify

Paper Read Read/Modify

Date/Time Read Read/Modify

Timer Read Read/Modify
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Menu Guest mode Administrator mode

Logs None Read/Modify

E-mail Read Read/Modify

Auto E-mail Notification None Read/Modify

On-demand E-mail
Notification

None Read/Modify

File Transfer None Read/Modify

User Authentication
Management

None Read/Modify

Administrator Authentication
Management

None Read/Modify

Program/Change
Administrator

None Read/Modify

LDAP Server None Read/Modify

Firmware Update None Read/Modify

Program/Change Realm None Modify

Printer

Menu Guest mode Administrator mode

Basic Settings Read Read/Modify

Tray Parameters (PS) None Read/Modify

PDF Temporary Password Modify None

PDF Group Password None Modify

PDF Fixed Password None Modify

Scanner

Menu Guest mode Administrator mode

General Settings Read Read/Modify

Using Web Image Monitor
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Menu Guest mode Administrator mode

Scan Settings Read Read/Modify

Send Settings Read Read/Modify

Initial Settings None Read/Modify

Default Settings for Normal
Screens on Device

Read Read/Modify

Defaults Settings for Simplified
Screens on Device

Read Read/Modify

Interface

Menu Guest mode Administrator mode

Interface Settings Read Read/Modify

Wireless LAN Settings Read Read/Modify

Network

Menu Guest mode Administrator mode

IPv4 Read Read/Modify

IPv6 Read Read/Modify

NetWare Read Read/Modify

AppleTalk Read Read/Modify

SMB Read Read/Modify

SNMP None Read/Modify

SNMPv3 None Read/Modify

SSDP None Read/Modify

Bonjour Read Read/Modify

System Log Read Read

Security

2. Monitoring and Configuring the Printer
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Menu Guest mode Administrator mode

Network Security None Read/Modify

Access Control None Read/Modify

IPP Authentication None Read/Modify

SSL / TLS None Read/Modify

ssh None Read/Modify

Site Certificate None Read/Modify

Device Certificate None Read/Modify

IPsec None Read/Modify

User Lockout Policy None Read/Modify

S/MIME None Read/Modify

RC Gate

Menu Guest mode Administrator mode

Setup RC Gate None Read/Modify

Update RC Gate Firmware None Read

RC Gate Proxy Server None Read/Modify

Webpage

Menu Guest mode Administrator mode

Webpage Read/Modify Read/Modify

Extended Feature Settings

Menu Guest mode Administrator mode

Startup Setting None Read/Modify

Extended Feature Info Read Read

Install None Read/Modify

Using Web Image Monitor
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Menu Guest mode Administrator mode

Uninstall None Read/Modify

Change Allocation None Read/Modify

Administrator Tools None Read/Modify

Copy Extended Features None Read/Modify

Copy Card Save Data None Read/Modify

• Some items are not displayed depending on the security settings.

Displaying Web Image Monitor Help

When using Help for the first time, clicking the icon marked "? " ( ) makes the following screen
appear, in which you can view Help in two different ways, as shown below:

Viewing Help on our Web site

Downloading Help to your computer

Downloading and Checking Help

You can download Help to your computer. As the Help URL, you can specify the path to the local
file to view the Help without connecting to the Internet.

• By clicking "?" ( ) in the header area, the contents of Help appear.

• By clicking "?" ( ), the Help icon in the display area, Help for the setting items in the display
area appears.

Downloading Help

1. In the [OS] list, select the operating system.

2. In the [Language] list, select the language.

3. Click [Download].

4. Download Help by following the instructions on the screen.

5. Store the downloaded compressed file in a given location, and then decompress the file.

To create a link for the Help button ( ), save the downloaded Help files on a Web server.

2. Monitoring and Configuring the Printer
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Linking the URL of the downloaded Help

You can link the URL of the help file on a computer or Web server to the "?" button.

1. Log on to Web Image Monitor in the administrator mode.

2. In the menu area, click [Configuration].

3. Click [Webpage].

4. In the [Set Help URL Target] box, enter the URL of the help file.

If you saved the help file to "C:\HELP\EN", enter "file://C:/HELP/". For example, if you saved the
file to a Web server, and the URL of the index file is "http:// a.b.c.d/HELP/EN/index.html", enter
"http://a.b.c.d/HELP/".

5. Click [OK].

• If you save the Help files on your hard disk, you must access them directly - you cannot link to them
using the Help button ( ).

Using Web Image Monitor
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Using SmartDeviceMonitor for Admin
Using SmartDeviceMonitor for Admin, you can monitor the network printers. Also, you can change the
configuration of the network interface board using TCP/IP or IPX/SPX.

• IPv6 cannnot be used on this function.

Protocol stack provided with Operating System

• Windows 2000

TCP/IP

IPX/SPX

NetWare

Novell Client for Windows NT/2000/XP

• Windows Server 2003/2003 R2

TCP/IP

IPX/SPX

• Windows XP

TCP/IP

IPX/SPX

Novell Client for Windows NT/2000/XP

• Windows Vista

TCP/IP

Novell Client for Windows NT/2000/XP/Vista

Available operations

The following functions are available:

• Limits settings done from the control panel, and disables changes made to certain items.

• Enables selection of paper type loaded in the machine.

• Switches to, and comes out of Energy Saver mode.

• Checks information about printing, paper quantity, etc.

• Simultaneously monitors multiple printers. When there are many printers, you can create
groups and classify printers to facilitate management.

• Checks the machine's network settings and detailed device information.

• Enables you to change the machine's network settings.

• You can check details of print jobs sent from a computer.

2. Monitoring and Configuring the Printer
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• Allows you to check job histories of printed, scanned, and photocopied documents identified
by user codes.

• Allows selection of functions such as printing and scanning for each user code.

• You can check each fax job history entry.

• You can make settings for and display the status changes of group devices.

• Using Address Management Tool, you can manage user names for Scan to Folder.

• The e-mail sender's name and folder can be protected.

Installing SmartDeviceMonitor for Admin

Follow the procedure below to install SmartDeviceMonitor for Admin.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The following languages are available: Czech, Danish, German, English, Spanish, French, Italian,
Hungarian, Dutch, Norwegian, Polish, Portuguese , Finnish, and Swedish.

If you specify a language that is not shown in this list, the interface will be displayed in English.

4. Click [SmartDeviceMonitor for Admin].

5. Click [Next].

The software license agreement appears in the [License Agreement] dialog box.

6. After reading through its contents, click [Next].

7. Follow the instructions on the screen.

A message appears when the installation is completed.

8. Click [OK].

A message about restarting the computer may appear. Restart the computer to complete
installation.

• Auto Run may not work under certain operating system settings. In this case, launch "Setup.exe"
located on the CD-ROM root directory.

• If you are required to restart the computer after installing SmartDeviceMonitor for Admin, restart the
computer and continue the configuration.

Using SmartDeviceMonitor for Admin
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Changing the Network Interface Board Configuration

Follow the procedure below to change the network interface board configuration using
SmartDeviceMonitor for Admin.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. In the list, select a machine whose configuration you want to change.

4. On the [Tools] menu, click [NIB Setup Tool].

A Web browser opens and the window for entering the login user name and password for the
Web Image Monitor administrator appears.

NIB Setup Tool starts. Click [Web browser], and then click [OK].

5. Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network administrator.

6. Configure settings using Web Image Monitor.

7. Click [Logout].

8. Quit Web Image Monitor.

9. Quit SmartDeviceMonitor for Admin.

• For details about login user names and passwords, see Security Reference, which is the
administrator's manual.

• For details about Web Image Monitor, see "Using Web Image Monitor".

• p.21 "Using Web Image Monitor"
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Locking the Menus on the Machine's Control Panel

Follow the procedure below to lock the menus on the machine's control panel.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. Select a machine.

4. On the [Tools] menu, point to [Device Settings], and then click [System].

A Web browser opens and the window for entering the login user name and password for the
Web Image Monitor administrator appears.

5. Enter the login user name and password, and then click [Login].

For details about the user name and password, consult your network administrator.

The [System] page of Web Image Monitor appears.

6. On the [Protect Printer Display Panel], select [Level 1] or [Level 2].

7. Click [OK].

8. Click [Logout].

9. Quit Web Image Monitor.

10. Quit SmartDeviceMonitor for Admin.

• For details about login user names and passwords, see Security Reference, which is the
administrator's manual.

• For details about Web Image Monitor, see "Using Web Image Monitor".

• p.21 "Using Web Image Monitor"
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Changing the Paper Type

Follow the procedure below to change the paper type.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. In the list, select a machine whose configuration you want to change.

4. On the [Tools] menu, point to [Device Settings], and then click [Paper].

A Web browser opens and the window for entering the login user name and password for the
Web Image Monitor administrator appears.

5. Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network administrator.

The [Paper] page appears.

Select a paper type in the [Paper Type] list for each tray. Enter required setting items.

6. Click [Logout].

7. Quit Web Image Monitor.

8. Quit SmartDeviceMonitor for Admin.

• For details about login user names and passwords, see Security Reference, which is the
administrator's manual.

• For details about Web Image Monitor, see "Using Web Image Monitor".

• For details about setting items, see Help in the [General Settings] on [Configuration] page.

• p.21 "Using Web Image Monitor"

Managing User Information

Follow the procedure below to manage the user's information using SmartDeviceMonitor for Admin.

Prints jobs can be managed and functions restricted by user codes.
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Starting User Management Tool

Follow the procedure below to start User Management Tool.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. In the list, select a machine you want to manage.

4. On the [Tools] menu, click [User Management Tool].

A Web browser opens and the window for entering the login user mane and password for the
Web Image Monitor administrator appears.

5. Enter the user name and password, and then click [Login].

For details about the user name and password, consult your network administrator.

User Management Tool starts.

• For details about login user names and passwords, see Security Reference, which is the
administrator's manual.

• For details about User Management Tool, see SmartDeviceMonitor for Admin Help.

Displaying the Number of Sheets Printed

Follow the procedure below to display the number of sheets printed under each user.

1. Start SmartDeviceMonitor for Admin User Management Tool.

Using SmartDeviceMonitor for Admin
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2. Click the [User Counter Information] tab of User Management Tool.

The number of pages printed under each user appears.

3. Click [Exit] on the [File] menu to quit User Management Tool.

Exporting the information about the number of pages printed

Follow the procedure below to export the information of the number of pages printed under each user
as a .csv file.

1. Start SmartDeviceMonitor for Admin User Management Tool.

2. Click the [User Counter Information] tab of User Management Tool.

3. On the [File] menu, click [Export User Statistics List].

4. Specify the save location and file name, and then click [Save].

5. Click [Exit] on the [File] menu to quit User Management Tool.

Resetting the number of pages printed to 0.

Follow the procedure below to reset the number of pages printed under each user to 0.

1. Start SmartDeviceMonitor for Admin User Management Tool.
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2. Click the [User Counter Information] tab of User Management Tool.

3. Select the user whose information you want to reset.

4. On the [Edit] menu, click [Reset User Counters].

5. Select the check box of the items you want to reset, and then click [OK].

A confirmation message appears.

6. Click [OK].

The count for the selected paper type becomes 0 and [Modified] is displayed for [Status].

7. On the [Edit] menu, click [Apply Settings].

Changes are applied to information on the [User Counter Information] tab.

Using SmartDeviceMonitor for Admin
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8. Click [Exit] on the [File] menu to quit User Management Tool.

Restricting Functions

Follow the procedure below to restrict use of individual functions.

1. Start SmartDeviceMonitor for Admin User Management Tool.

2. Click the [User Counter Information] tab of User Management Tool.

3. Click the user whose functions you want to restrict.

4. On the [Edit] menu of User Management Tool, click [Restrict Access To Device].

5. Select the check box of the functions you want to restrict.

6. Click [OK].

A confirmation message appears.

7. Click [Yes].

The settings are applied.

8. Click [Exit] on the [File] menu to quit User Management Tool.

Setting Applicable Functions to New Users

Follow the procedure below to add new users and set functions applicable to them.

1. Start SmartDeviceMonitor for Admin User Management Tool.
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2. Click the [Access Control List] tab of User Management Tool.

3. On the [Edit] menu, click [Adds New User].

4. Enter the user code and user name.

5. Select the check box of the functions applicable to the new user.

If the check boxes are unavailable, there is no restriction to use that function.

6. Click [OK].

The user is added, and [New] is displayed for [Status].

7. On the [Edit] menu, click [Apply Settings].

The settings are applied.

8. Click [Exit] on the [File] menu to quit User Management Tool.

• For details about setting restrictions, see SmartDeviceMonitor for Admin Help.

Using SmartDeviceMonitor for Admin
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Configuring the Energy Saver Mode

Follow the procedure below to configure Energy Saver mode.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. Select the machine whose settings you want to make.

To make settings for all machines in the selected group, select no machine.

4. Click the [Group] menu, point to [Energy Save Mode], [Set Individually], and then click
[On].

To select all the machines in the group, select [Set By Group].

To disable Energy Save mode, click [Off].

5. Quit SmartDeviceMonitor for Admin.

• For details about the setting for Energy Saver mode, see SmartDeviceMonitor for Admin Help.

Setting a Password

Follow the procedure below to set a password.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of machines using the selected protocol appears.
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Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. In the list, select a machine whose configuration you want to change.

4. On the [Tools] menu, click [NIB Setup Tool].

A Web browser opens and the dialog box for entering the login user name and password for the
Web Image Monitor administrator appears.

NIB Setup Tool starts when the network interface board is default. Follow the instructions on the
screen.

5. Enter the login user name and password, and then click [Login].

For details about the user name and password, consult your network administrator.

6. Click [Configuration].

7. Click [Program/Change Administrator] on the [Device Settings] area, and then change
the settings.

8. Click [Logout].

9. Quit Web Image Monitor.

10. Quit SmartDeviceMonitor for Admin.

• For details about login user names and passwords, see Security Reference, which is the
administrator's manual.

Checking the Machine Status

Follow the procedure below to check machine status.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using TCP/IP SNMP v3, enter the user authentication.

Using SmartDeviceMonitor for Admin
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3. Click the [View] menu, and then click [Select List Columns].

4. From [Device] in the [Select List Columns] dialog box, select the items you want to
display, and then click [Add].

Selected items will move to [Show].

5. Move all the items you want to display, and then click [OK].

An icon in the list indicates the machine's status.

6. For information about a machine's status, select the machine you want to know about,
and then click [Open] in the [Device Settings] menu.

The dialog box of the selected machine appears.

7. Click the application whose status you want to view.

The machine's status is displayed.

8. Quit SmartDeviceMonitor for Admin.

• For details about items in the dialog box, see SmartDeviceMonitor for Admin Help.

Changing Names and Comments

Follow the procedure below to change the names and comments of the machine.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. Select a machine in the list, and then click [NIB Setup Tool] on the [Tools] menu.

A Web browser opens and the window for entering the login user name and password for the
Web Image Monitor administrator appears.

NIB Setup Tool starts when the network interface board is default. Follow the instructions on the
screen.

4. Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network administrator.

5. Click [System] on the [Device Settings] area, and then change the settings.

6. Click [Logout].

7. Quit Web Image Monitor.
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8. Quit SmartDeviceMonitor for Admin.

• In the [Device Name] box, enter a device name on the machine using up to 31 characters.

• In the [Comment] box, enter a comment on the machine using up to 31 characters.

• For details about login user names and passwords, see Security Reference, which is the
administrator's manual.

• For details about Web Image Monitor, see "Using Web Image Monitor".

• p.21 "Using Web Image Monitor"

Viewing and Deleting Spool Print Jobs

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. Select a machine in the list, and then click [Spool Printing Job List(Printer)] on the [Tools]
menu.

A Web browser opens and the dialog box for entering the login user name and password for the
Web Image Monitor administrator appears.

4. Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network administrator.

[Spool Printing Job List] appears in the Web Image Monitor.

5. Click [Logout].

6. Quit Web Image Monitor.

7. Quit SmartDeviceMonitor for Admin.

• To display Spool Printing Job List, [Spool Printing] must be set to [Active] on Web Image Monitor in
advance.

• To delete the Spool Printing Job, select the document you want to delete and then click [Delete].

• For details, see Help in the [Spool Printing Job List] area.

• For details about login user names and passwords, see Security Reference, which is the
administrator's manual.
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• For details about Web Image Monitor, see "Using Web Image Monitor".

• p.21 "Using Web Image Monitor"

Managing Address Information

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. Select a machine in the list, and then click [Address Management Tool] on the [Tools]
menu.

The dialog box for entering the login user name and password appears.

4. Enter the login user name and password, and then click [OK].

For details about the login user name and password, consult your network administrator.

[Address Management Tool] starts. Make the necessary settings.

5. Click [Exit].

6. Quit SmartDeviceMonitor for Admin.

• For details, see Address Management Tool Help.

• For details about login user names and passwords, see Security Reference, which is the
administrator's manual.

• For details about Web Image Monitor, see "Using Web Image Monitor".

• p.21 "Using Web Image Monitor"
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Using SmartDeviceMonitor for Client
To view the status of machines using SmartDeviceMonitor for Client, configure SmartDeviceMonitor for
Client beforehand.

Monitoring Printers

Follow the procedure below to monitor the machine using SmartDeviceMonitor for Client.

1. Right-click the SmartDeviceMonitor for Client icon, point to [Properties], and then click
[Monitor Device Settings...].

The SmartDeviceMonitor for Client [- Options] dialog box appears.

2. On the [Printers Folder] tab, select the machine you want to monitor, and then select the
[To Be Monitored] check box in the Monitoring Information Settings area.

To display the machine status on the task bar, you must first select the [To be Monitored] check
box, and then select the [Display on the task bar menu] check box.

3. Click [OK].

The dialog box closes and the configured machine is monitored.
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• For details about status icons, see SmartDeviceMonitor for Client Help.

Checking the Machine Status

Follow the procedure below to check machine status using SmartDeviceMonitor for Client.

1. Right-click the SmartDeviceMonitor for Client icon, and then click the machine.

The machine status appears in the dialog box.

• For details about items in the dialog box, see SmartDeviceMonitor for Client Help.

When Using IPP with SmartDeviceMonitor for Client

When using IPP with SmartDeviceMonitor for Client, note the following:

• The network printer can only receive one print job from SmartDeviceMonitor for Client at a time.
While the network printer is printing, another user cannot access it until the job is finished. In this
case, SmartDeviceMonitor for Client tries to access the network printer until the retry interval
expires.

• If SmartDeviceMonitor for Client cannot access the network printer and times out, it will stop
sending the print job. In this case, you should cancel the paused status from the print queue
window. SmartDeviceMonitor for Client will resume access to the network printer. You can delete
the print job from the print queue window, but canceling a print job printed by the network printer
might cause the next job sent from another user to be incorrectly printed.

• If a print job sent from SmartDeviceMonitor for Client is interrupted and the network printer cancels
the job because something went wrong, send the print job again.

• Print jobs sent from another computer do not appear in the print queue window, regardless of
protocol.

• If various users send print jobs using SmartDeviceMonitor for Client to network printers, the printing
order might not be the same as that in which the jobs were sent.
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• An IP address cannot be used for the IPP port name because the IP address is used for the
SmartDeviceMonitor for Client port name.

• When setting SSL, a protocol for encrypted communication, under environment which server
authentication is issued, enter “https://( machine's IP address or host name)/ ”. Internet Explorer
must be installed on your computer. Use the highest version. Internet Explorer 6.0 or higher is
recommended.

• If the [Security Alert] dialog box appears when accessing the machine using IPP to create or
configure an IPP port, or when printing, install the certificate. To select the certificate store location
when using Certificate Import Wizard, click [Place all certificates in the following store], and then
click [Local Computer] under [Trusted Root Certification Authorities].

• For details about SSL settings, consult your network administrator.
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Printer Status Notification by E-Mail
Whenever a paper tray becomes empty or paper is jammed, an e-mail alert is issued to the registered
addresses to notify the printer status.

For this notification, you can make the e-mail notification settings.

Notification timing and e-mail content can be set.

• Depending on your e-mail application, a phishing warning might appear after you receive an e-
mail message. To prevent phishing warnings appearing after you receive e-mail from a specified
sender, you must add the sender to your e-mail application's exclusion list. For details about how to
do this, see your e-mail application's Help.

You can be notified of the following events:

• Service call.

• Toner cartridge is empty.

• Toner cartridge is nearly empty.

• Paper has jammed.

• Open door is detected.

• The paper tray is empty.

• The paper tray is nearly empty.

• A paper tray error occurred.

• Output paper tray is full.

• Unit connection error.

• Waste toner bottle is full.

• Service call is successful.

• File storage memory is nearly full.

• Log error.

• Device access is violated.

1. Log on to Web Image Monitor in administrator mode.

2. In the menu area, click [Configuration].

3. Click [E-mail] on the [Device Settings] area.

4. Make the following settings:

• Items in the Reception column: Make the necessary settings for sending and receiving e-mail.
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• Items in the SMTP column: Configure the SMTP server. Check your mailing environment, and
then specify the necessary items. You can also perform mail authentication for the SMTP
server.

• Items in the POP before SMTP column: Configure the POP server. Check your mailing
environment, and then specify the necessary items. You can also perform mail authentication
for the POP server.

• Items in the POP3/IMAP4 column: Configure the POP3 or IMAP4 server. Check your mailing
environment, and then specify the necessary items.

• Items in the E-mail Communication Port column: Configure the port to be used for access to the
mail server.

5. Click [OK].

6. Click [Logout].

7. Quit Web Image Monitor.

• For details about login user name and password, see Security Reference, which is the
administrator's manual.

• For details about the settings, see Web Image Monitor Help.

• For details about Web Image Monitor, see “Using Web Image Monitor”.

• p.21 "Using Web Image Monitor"

Auto E-mail Notification

1. Log on to Web Image Monitor in administrator mode.

2. Click [Configuration] in the menu area, and then click [Auto E-mail Notification] on the
[Device Settings] area.

The dialog box for making notification settings appears.

3. Make the following settings:

• Items in Notification Message column: You can set this according to your needs, for example,
the machine's location, service representative contact information.

• Items in the Groups to Notify column: E-mail notification addresses can be grouped as
required.

• Items in the Select Groups/Items to Notify column: Select groups for each notification type,
such as machine status and error.

To make detailed settings for these items, click [Edit] next to [Detailed Settings of Each Item].

4. Click [OK].

Printer Status Notification by E-Mail

53



5. Click [Logout].

6. Quit Web Image Monitor.

• For details about Web Image Monitor, see “Using Web Image Monitor”.

• For details about the settings, see Web Image Monitor Help.

• p.21 "Using Web Image Monitor"

On-demand E-mail Notification

1. Log on to Web Image Monitor in administrator mode.

2. Click [Configuration] in the menu area, and then click [On-demand E-mail Notification] on
the [Device Settings] area.

The dialog box for making notification settings appears.

3. Make the following settings:

• Notification Subject column: Enter a text string to be added to the subject line of return e-
mails.

• Items in Notification Message column: You can set this according to your needs, for example,
the machine's location, service representative contact information.

• Items in the Access Restriction to Information column: Select whether to restrict accesses based
on a specific category of information.

• Items in the Receivable E-mail Address/Domain Name Settings column: Enter an e-mail
address or domain name to use for requesting information by e-mail and to receive its return
e-mail.

4. Click [OK].

5. Click [Logout].

6. Quit Web Image Monitor.

• For details about Web Image Monitor, see “Using Web Image Monitor”.

• For details about the settings, see Web Image Monitor Help.

• p.21 "Using Web Image Monitor"
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Mail Authentication

You can configure mail authentication to prevent illegal use of the mail server.

SMTP Authentication

Specify SMTP authentication.

When mail is sent to the SMTP server, authentication is performed using the SMTP AUTH protocol
by prompting the mail originator to enter the user name and password. This prevents illegal use of
the SMTP server.

1. Log on to Web Image Monitor in administrator mode.

2. Click [Configuration] in the menu area, and then click [E-mail] on the [Device Settings] area.

3. Make the following settings in SMTP column:

• SMTP Server Name: Enter the IP address or host name of the SMTP server

• SMTP Port No.: Enter the port number used when sending e-mail to the SMTP server.

• SMTP Authentication: Enable or disable SMTP authentication.

• SMTP Auth. E-mail Address: Enter the e-mail address.

• SMTP Auth. User Name: Enter the SMTP account name.

• SMTP Auth. Password: To set or change the password for SMTP AUTH.

• SMTP Auth. Encryption: Select whether to encrypt the password or not.

[Encryption]-[Auto Select]: If the authentication method is PLAIN, LOGIN, CRAM-MD5,
or DIGEST-MD5.

[Encryption]-[Active]: If the authentication method is CRAM-MD5 or DIGEST-MD5.

[Encryption]-[Inactive]: If the authentication method is PLAIN or LOGIN.

4. Click [OK]

5. Click [Logout].

6. Quit Web Image Monitor.

POP before SMTP Authentication

Select whether to log on to the POP3 server before sending e-mail.

1. Log on to Web Image Monitor in administrator mode.

2. Click [Configuration] in the menu area, and then click [E-mail] Notification on the [Device
Settings] area.

3. Make the following settings in POP before SMTP column:

• POP before SMTP: Enable or disable POP before SMTP.

• POP E-mail Address: Enter the e-mail address.

• POP User Name: Enter the POP account name.
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• POP Password: To set or change the POP password.

• Timeout setting after POP Auth.: Enter the time available before connecting to the SMTP
server after logging on to the POP server.

4. Click [OK].

5. Click [Logout].

6. Quit Web Image Monitor.

Sending E-mail Notification

To use on-demand e-mail notification, perform the following configuration tasks in Web Image Monitor.

1. Log on to Web Image Monitor in administrator mode.

2. Click [Configuration] in the menu area, and then click [E-mail] on the [Device Settings] area.

3. Make the following settings:

• E-mail Notification E-mail Address: Enter the address using alphanumeric characters.

• Receive E-mail Notification: Specify whether to use on-demand e-mail notification.

• E-mail Notification User Name: Enter the administrator's user name as the mail originator
name.

• E-mail Notification Password: Enter the password of the mail notification user.

4. Click [OK].

5. Click [Logout].

6. Quit Web Image Monitor.

Format of on-demand e-mail messages

To use mail notification, you need to send an on-demand e-mail message to this machine.

Using your mail software, enter the following:

Item Description

Subject (Referred to as Subject) Enter a request regarding the device. For
details, see the table below.

From (Referred to as From) Specify a valid mail address. The device
information will be sent to the address
specified here.

• A mail message must be within 1 MB in size.

• E-mail may be incomplete if sent immediately after power on.
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Subject field

Format: devicestatus?parameter-name=parameter[&=parameter][& =parameter]...

• The Subject field is case-insensitive.

• Parameter names can be written in any order.

Subject field coding examples

Coding example Action

devicestatus?request=sysconfig&
format=text&lang=en

The device's system configurationinformation will
be sent in an English text format.

devicestatus?request=sysconfig The device's system configurationinformation will
be sent in a preset format and language.

• The Subject field is case-insensitive.

• Parameter names can be written in any order.

Parameters

Parameter Meaning Default

request Information to be obtained Mandatory

format Mail format Mail will be sent in the format
presetfor each mail address.

lang Language for mail body Mail will be sent in the
languagepreset for each mail
address.

Parameters specifying the information to be obtained

Information to be obtained Parameter

System configuration information sysconfig

Network configuration information netconfig

Printer configuration information prtconfig

Supplies information supply

Device status information status
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Parameters specifying the mail format

Mail format Parameter

Text text

HTML html

XML xml

• HTML and XML can be seleceted for subject field, but output is text only.

Parameters that specify the language for mail bodies

Language Parameter

Japanese ja

English en
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Remote Maintenance by telnet

• Remote Maintenance should be protected so that access is allowed to administrators only.

• The password is the same as the one of Web Image Monitor administrator. When the password is
changed using "mshell", other's change also.

Using telnet

Follow the procedure below to use telnet.

• Only one user at a time can log on to perform remote maintenance.

• If you are using Windows Vista, you must enable the telnet server and telnet client beforehand.

1. Use the IP address or the host name of the machine to start telnet.

% telnet "IP_address"

2. Enter your user name and password.

For details about the user name and password, consult your network administrator.

For user authentication, enter a login user name and password.

For user code authentication, enter a user code in User Name.

3. Enter a command.

4. Quit telnet.

msh> logout

The configuration message about saving the changes appears.

5. Enter "yes" to save the changes, and then press the [Enter] key.

If you do not want to save the changes, enter "no", and then press the [Enter] key. To make further
changes, enter "return" at the command line, and then press the [Enter] key.

• If the message "Can not write NVRAM information" appears, the changes are not saved. Repeat
the procedure above.

• When the changes are saved, the network interface board is reset automatically with that changes.

• When the network interface board resets, the print job in print process will be printed. However,
print jobs in queue will be canceled.

• To use Telnet under Windows Vista, SmartDeviceMonitor for Client must be installed.
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access

Use the "access" command to view and configure access control. You can also specify two or more
access ranges.

View settings

msh> access

IPv4 configration display

msh> access ID range

IPv6 configuration display

msh> access ID range6

IPv6 access mask configuration display

msh> access ID mask6

IPv4 configuration

msh> access ID range "start-address end-address"

Example: to specify accessible IPv4 addresses between 192.168.0.10 and 192.168.0.20:

msh> access 1 range 192.168.0.10 192.168.0.20

IPv6 configuration

msh> access ID range6 "start-address end-address"

Example: to specify accessible IPv6 addresses between 2001:DB8::100 and 2001:DB8::200.

msh> access 1 range6 2001:DB8::100 2001:DB8::200

IPv6 access mask configuration

msh> access ID mask6 "base-address prefixlen"

Example: to specify accessible IPv6 addresses to 2001:DB8::/32

msh> access 1 mask6 2001:DB8:: 32

Access control initialization

msh> access flush

• Use the "flush" command to restore the default settings so that all access ranges become
"0.0.0.0" for IPv4, and "::" for IPv6.

• You can specify each IPv6 entry by either range or mask. For the range parameter, you can select
"start-address end-address". For the mask parameter, you can select "baseaddress prefixlen".

• The access range restricts computers from use of the machine by IP address. If you do not need to
restrict printing, make the setting "0.0.0.0" for IPv4, and "::" for IPv6.

• Valid ranges must be from lower (start address) to higher (end address).
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• For IPv4 and IPv6, you can select an ID number between 1 and 5.

• IPv6 can register and select the range and the mask for each access ranges.

• IPv6 mask ranges between 1 - 128 can be selected.

• Up to five access ranges can be specified. The entry is invalid if the target number is omitted.

• You cannot send print jobs, or access Web Image Monitor and diprint from a restricted IP address.

appletalk

Use the "appletalk" command to view and configure AppleTalk parameters.

View settings

msh> appletalk

• [2] means "active" and [0] means "inactive".

• The default is [2].

Changing PAP timeout configuration

msh> appletalk ptimeout value > 0

• Timeout value becomes effective.

msh> appletalk ptimeout value = 0

• Timeout value becomes ineffective.

autonet

Use the "autonet" command to configure AutoNet parameters.

View settings

The following command displays the current AutoNet settings:

msh> autonet

Configuration

You can configure AutoNet settings.

msh> autonet {on|off}

• {on} means "active" and {off} means "inactive".

Current interface priority configuration display

msh> autonet priority

Interface priority configuration

msh> autonet priority "interface_name"

• You can give interface's AutoNet parameter priority.
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• Priority settings are available when multiple interfaces are installed.

• wlan can be specified only when the IEEE 802.11 interface is installed.

Interface Interface configured

ether Ethernet interface

wlan IEEE 802.11 interface

• If an interface is not selected, the current interface connection settings remain in effect.

• For details about AutoNet, refer to autonet parameters.

bonjour (rendezvous)

Use the "bonjour (rendezvous)" command to display bonjour (rendezvous)-related settings.

View settings

Bonjour settings are displayed.

msh> bonjour

Bonjour service name setting

You can specify the bonjour service name.

msh> bonjour cname "computer name"

• The computer name can be entered using up to 63 alphanumeric characters.

• If you do not specify a character string, the current setting is displayed.

Bonjour Installation location information setting

You can enter information about the location where the printer is installed.

msh> bonjour location "location"

• Information about location can be entered using up to 32 alphanumeric characters.

• If you do not specify a character string, current setting is displayed.

Setting order of priority for each protocol

• msh> bonjour diprint [0-99]

• msh> bonjour lpr [0-99]

• msh> bonjour ipp [0-99]

You can specify the order of priority for "diprint", "lpr", and "ipp". Smaller numbers indicate higher
priority.
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IP TTL setting

msh> bonjour ip ttl [1-255]

You can specify the IP TTL (the number of routers a packet can pass through).

• The default is 255.

Resetting the computer name and location information

You can reset the computer name and location information.

msh> bonjour clear {cname|location}

• cname: Reset the computer name. The default computer name will be displayed when the
computer is restarted.

• location: Reset the location information. The previous location information will be deleted.

Interface configuration

msh> bonjour linklocal "interface_name"

• If you do not specify an interface, the Ethernet interface is selected automatically.

• If many types of interface are installed, configure the interface that communicates with
linklocal address.

• If you do not specify an interface, the Ethernet interface is automatically selected.

• wlan can be specified only when the IEEE 802.11 interface is installed.

Interface Interface configured

ether Ethernet interface

wlan IEEE 802.11 interface

Setting IPP-SSL printing

msh> bonjour ippport {ipp|ssl}

• If IPP-SSL Printing is set to ssl, the IPP port number will appear as 443, and IPP-SSL printing
can be performed with higher security.

• If IPP-SSL Printing is set to ipp, the IPP port number will appear as 631. Port 631 is the port for
normal IPP printing.

btconfig

Use the "btconfig" command to make Bluetooth settings.

View settings

Bluetooth settings are displayed.

msh> btconfig
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Mode settings

You can set the Bluetooth operation mode to {private} or {public}.

msh> btconfig {private|public}

• The default is {public}.

devicename

Use the "devicename" command to display and change the printer name.

View settings

msh> devicename

Printer name configuration

msh> devicename name "string"

• Enter a printer name using up to 31 alphanumeric characters.

• Set single names for each printer.

Printer name initialization

msh> devicename clear name

• Reset the printer name to its default.

dhcp

Use the "dhcp" command to configure DHCP settings.

View settings

The following command displays the current DHCP settings.

msh> dhcp

Configuration

You can configure DHCP.

msh> dhcp "interface_name" {on|off}

• Click {on} to enable dhcp. Click {off} to disable DHCP.

• If the DNS server address and domain name are obtained from DHCP, be sure to click {on}.

• wlan can be specified only when the IEEE 802.11 interface is installed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11 interface
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Current interface priority configuration display

msh> dhcp priority

Interface priority configuration

msh> dhcp priority "interface_name"

• You can select which interface has DHCP parameter priority.

• Priority settings are available when multiple interfaces are installed.

DNS server address selection

msh> dhcp dnsaddr {dhcp|static}

• Specify whether to obtain the DNS server address from the DHCP server or use the address
set by a user.

• To obtain the DNS server address from the DHCP server, specify "dhcp". To use the address
set by a user, specify "static".

Domain name selection

msh> dhcp domainname {dhcp|static}

• Specify whether to obtain the domain name from the DNS server or use the domain name set
by a user.

• To obtain the domain name from the DHCP server, specify "dhcp". To use the domain name
set by a user, specify "static".

• p.67 "dns"

• p.68 "domainname"

• p.133 "Using DHCP"

dhcp6

Use the "dhcp6"command to display or configure DHCPv6 settings.

View settings

The following command displays the current DHCPv6 settings.

msh> dhcp6

DHCPv6-lite configuration and display

msh> dhcp6 "interface_name" lite {on|off}

Viewing and specifying DNS server address selection (obtained from the dhcpv6 server/user
specified value)

msh> dhcp6 dnsaddr {dhco|static}
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DUID(DHCP unique ID) deletion and display

msh> dhcp6 duid clear

Viewing and specifying the time required to re-obtain the parameter obtained from dhcpv6

msh> dhcp6 option lifetime [0-65535]

• It can be entered between 0 and 65535 minutes.

• The default is 60 minutes.

• If you specify "0", you cannot re-obtain the value.

diprint

The direct printing port enables direct printing from a network-connected computer.

Use the "diprint" command to change direct printing port settings.

View settings

The following command displays the current direct printing port settings:

msh> diprint

Example output:

port 9100

timeout=300(sec)

bidirect on

conn multi

apl async

• The "port" specifies the port number of the direct printing port.

• The "bidirect" setting indicates whether the direct printing port is bidirectional or not.

Setting timeout

msh> diprint timeout [30-5535]

• You can specify the timeout interval to use when the printer is expecting data from the
network.

• The default is 300 seconds.

Specifying the number of concurrent connections

msh> diprint conn {multi|single}

• The above command specifies the number of concurrent diprint connections. Specify "multi"
for multiple connections or "single" for a single connection.

• The default is "multi".
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dns

Use the "dns" command to configure or display DNS (Domain Name System) settings.

View settings

The following command displays current DNS settings:

msh> dns

IPv4 DNS server configuration

The following command enables or disables the IPv4 DNS server address:

msh> dns "ID" server "server address"

The following command displays a configuration using the IP address 192.168.15.16 on a DNS 1
server:

msh> dns 1 server 192.168.15.16

• You can register IPv4 DNS Server address.

• You can select an ID number between 1 and 3. You can select up to three ID numbers.

• You cannot use "255.255.255.255" as the DNS server address.

IPv6 DNS server configuration

The following command enables or disables the IPv4 DNS server address:

msh> dns "ID" server6 "server address"

• You can register IPv6 DNS Server address.

• The selectable ID number is between 1 and 3. You can select up to 3 ID.

Dynamic DNS function setting

msh> dns "interface_name" ddns {on|off}

• You can set the dynamic DNS function "active" or "inactive".

• {on} means "active" and {off} means "inactive".

• wlan can be specified only when the IEEE 802.11 interface is installed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11 interface

Specifying the record overlap operation

msh> dns overlap {update|add}

• You can specify operations performed when records overlap.

• update: To delete old records and register new records.
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• add: To add new records and store the old records.

• When CNAME overlaps, it is always changed, irrespective of settings.

CNAME registration

msh> dns cname {on|off}

• You can specify whether to register CNAME.

• {on} means "active" and {off} means "inactive".

• The CNAME registered is the default name beginning with rnp. CNAME cannot be changed.

A records registration

msh> dns arecord {dhcp|own}

• dhcp: You can specify the method of registering an A record when the dynamic DNS function
is enabled and DHCP is used.

• own: To register an A record using the printer as the DNS client.

The DNS server address and the domain name already designated are used for the
registration.

Record updating interval settings

msh> dns interval [1-255]

• You can specify the interval after which records are updated when using the dynamic DNS
function.

• The updating interval is specified hourly. It can be entered between 1 and 255 hours.

• The default is 24 hours.

resolv.conf display

msh> dns resolv

Specifying the protocol when asking names during dual stacking

msh> dns resolv protocol {ipv4|ipv6}

• Appears during dual stacking only.

domainname

Use the "domainname" command to display or configure the domain name settings.

You can configure the Ethernet interface,or IEEE 802.11 interface.

View settings

The following command displays the current domain name:

msh> domainname
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Interface domain configuration

msh> domainname "interface_name"

Setting the Domain Name

msh> domainname "interface_name" name "domain name"

• A domain name can be entered using up to 63 alphanumeric characters.

• The Ethernet interface and IEEE 802.11 interface will have the same domain name.

• wlan can be specified only when the IEEE 802.11 interface is installed.

Interface Interface set

ether Ethernet interface

wlan IEEE 802.11 interface

Deleting the Domain Name

msh> domainname "interface_name" clear name

help

Use the "help" command to display the available command list and the procedures for using those
commands.

Command list display

msh> help

Display of procedure for using commands

msh> help "command_name"

hostname

Use the "hostname" command to change the printer name.

View settings

msh> hostname

IPv4 Configuration

msh> hostname "interface_name" "printer_name"

• Enter the printer name using up to 63 alphanumeric characters.

• You cannot use a printer name beginning "RNP" (in either upper or lower case).

• The Ethernet interface and IEEE 802.11 interface will have the same printer name.
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• wlan can be specified only when the IEEE 802.11 interface is installed.

• If you do not specify an interface, the Ethernet interface is selected automatically.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11 interface

Initializing the printer name for each interface

msh>hostname "interface_name" clear name

ifconfig

Use the "ifconfig" command to view and configure TCP/IP (IP address, subnet mask, broadcast address,
default gateway address) for the printer.

View settings

msh> ifconfig

IPv4 configuration

msh> ifconfig "interface_name" "parameter" "address"

• If you did not enter an interface name, it is automatically set to the Ethernet interface.

• wlan can be specified only when the IEEE 802.11 interface is installed.

Interface name Interface configured

ether Ethernet Interface

wlan IEEE 802.11 Interface

The following explains how to configure an IPv4 address 192.168.15.16 on Ethernet interface.

msh> ifconfig ether 192.168.15.16

IPv6 configuration

msh> ifconfig ether inet6 "interface_name" "printer_name"

The following explains how to configure a IPv6 address to 2001:DB8::100 with prefix length 64
on the Ethernet interface.

msh> ifconfig ether inet6 2001:DB8::100 64

Netmask configuration

msh> ifconfig "interface_name" netmask "address"
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The following explains how to configure a subnet mask 255.255.255.0 on Ethernet interface.

msh> ifconfig ether netmask 255.255.255.0

Broadcast address configuration

msh> ifconfig "interface_name" broadcast "address"

Changing the interface

msh> ifconfig "interface" up

• When using the optional IEEE 802.11 interface unit, you can specify either Ethernet or IEEE
802.11 interface.

• To get the above addresses, contact your network administrator.

• Use the default configuration if you cannot obtain setting addresses.

• The IP address, subnet mask and broadcast address are the same as that for the ethernet interface
and IEEE 802.11 interface.

• TCP/IP configuration is the same for both Ethernet and IEEE 802.11 interface. If interfaces are
changed, the new interface inherits the configuration.

• Use "0x" as the initial two letters of a hexadecimal address.

info

Use the "info" command to display printer information such as paper tray, output tray, and printer
language.

Printer information display

msh> info

• p.107 "Understanding the Displayed Information"

ipp

Use the "ipp" command to view and configure IPP settings.

Viewing settings

The following command displays the current IPP settings:

msh> ipp

IPP timeout configuration

Specify how many seconds the computer waits before canceling an interrupted print job. The time
can be entered between 30 to 65535 seconds.
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msh> ipp timeout [30-65535]

IPP user authorization configuration

Use IPP user authorization to restrict users to print with IPP. The default is "off".

msh> ipp auth {basic|digest|off}

• User authorization settings are "basic" and "digest".

• If user authorization is specified, register a user name. You can register up to 10 users.

IPP user name configuration

Configure IPP users according to the following messages:

msh> ipp user

The following message appears:

msh> Input user number (1 to 10):

Enter the number, user name, and password.

msh> IPP user name:user1

msh> IPP :*******

After configuring the settings, the following message appears:

User configuration changed.

ipv6

Use the "ipv6" command to display and configure IPv6 settings.

View Setting

msh> ipv6

IPv6 stateless address

msh> ipv6 stateless {on|off}

If "on" is selected, IPv6 requests information required for maintaining stateful connection to the
router for as long as the printer power is turned on. This setting allows information from the router to
be obtained constantly, and periodically refreshes the effective period of the stateless address.

lpr

Use the "lpr" command to view and configure LPR settings.

View Setting

msh> lpr
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Checking host name when deleting the job

msh> lpr chkhost {on|off}

If "on" is selected, you can delete print jobs only from the IP address of the host that sent the print
job. If LPR is disabled, you can also delete print jobs sent from IP addresses other than that of the
host.

Printer Error Detection Function

lpr prnerrchk {on|off}

If you set this to "on", the printer stops receiving data and will wait until the error is resolved before
continuing processing a job.

netware

Use the "netware" command to view and configure the NetWare settings such as the print server name
or file server name.

NetWare Printer Server Names

msh> netware pnamecharacter string

• Enter the NetWare print server name using up to 47 characters.

NetWare File Server Names

msh> netware fname character string

• Enter the NetWare file server name using up to 47 characters.

Encap type

msh> netware encap {802.3|802.2|snap|ethernet2|auto}

Remote Printer Number

msh> netware rnum [0-254]

• The default is 0.

Timeout

msh> netware timeout [3-255]

• The default is 15.

Printer server mode

msh> netware mode pserver

msh> netware mode ps

Remote printer mode

msh> netware mode rprinter

msh> netware mode rp
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NDS context name

msh> netware context "character string"

SAP interval

msh> netware "sap_interval[0-3600]"

It can be entered between 0 and 3600 seconds.

Setting login mode for file server

msh> netware login server

Setting login mode for NDS tree

msh> netware login tree

Setting login mode for NDS tree name

msh> netware tree "NDS tree name"

File transfer protocol

msh> netware trans {ipv4pri|ipxpri|ipv4|ipx}

• If you do not specify the protocol, the current setting is displayed.

Protocol Set Protocol

ipv4pri IPv4+IPX(IPv4)

ipxpri IPv4+IPX(IPX)

ipv4 IPv4

ipx IPX

passwd

Use the "passwd" command to change the remote maintenance password.

Changing the

msh> passwd

• Enter the current password.

• Enter the new password.

• Renter the new password to confirm it.

Changing the password of the administrators using the Supervisor

msh> passwd {Administrator ID}

• Enter the new password.

• Renter the new password to confirm it.
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• Be sure not to forget or lose the password.

• The password can be entered using up to 32 alphanumeric characters. s are case-sensitive. For
example, "R" is not the same as "r".

pathmtu

Use the "pathmtu" command to display and configure the PathMTU Discovery service function.

View settings

msh> pathmtu

Configuration

msh> pathmtu {on|off}

• The default is "on".

• If the MTU size of the sent data is larger than the router's MTU, the router will declare it
impassable, and communication will fail. If this happens, selecting the "pathmtu" to "off"
optimizes the MTU size and prevents data output failure.

• Depending on the environment, information might not be obtained from the router, and
communication will fail. If this happens, select the "pathmtu" to "off".

prnlog

Use the "prnlog" command to obtain printer log information.

Print logs display

msh> prnlog

• Display previous print jobs.

msh> prnlog "ID Number"

• Specify the ID number of the displayed print log information to display additional details
about a print job.

route

Use the "route" command to view and control the routing table.

Specified route information display

msh> route get "destination"

• Specify the IPv4 address to destination.
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"0.0.0.0" cannot be specified as destination address.

Enabling/disabling specified IPv4 destination

msh> route active {host|net} "destination" {on|off}

• If you do not specify {host|net}, the host setting is automatically selected.

Adding IPv4 Routing Table

msh> route add {host|net} "destination" "gateway"

• Adds a host or network route to "destination", and a gateway address to "gateway" in the
table.

• Specify the IPv4 address to destination and gateway.

• If you do not specify {host|net}, the host setting is selected automatically.

• You cannot specify"0.0.0.0" as the destination address.

Setting the Default IPv4 Gateway

msh> route add default "gateway"

Deleting specified IPv4 destination from Routing Table

msh> route delete {host|net} "destination"

• If you do not specify {host|net}, the host setting is automatically selected.

• IPv4 address of destination can be specified.

Setting IPv6 Default Gateway

msh> route add6 default gateway

Adding a specified IPv6 destination to Routing Table

msh> route add6 "destination" "prefixlen[1-128]" "gateway"

• Specify the IPv6 address to destination and gateway.

• If the prefix of the address is between 1 and 127, the network is selected. If the prefix of the
address is 128, the host is selected.

• You cannot register a record that has the same destination and prefix as a registered record.

• You cannot register a record that uses "0000:0000:0000:0000:0000:0000:0000:0000"
as its destination.

Deleting a specified IPv6 destination from Routing Table

msh> route delete6 "destination" "prefixlen"

• Specify the IPv6 address to destination and gateway.

Display information about a specified IPv6 route information

msh> route get6 "destination"

• Specify the IPv6 address to destination and gateway.
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Enabling/disabling a specified IPv6 destination

msh> route active6 "destination" "prefixlen[1-128]" {on|off}

Route initialization

msh> route flush

• The maximum number of IPv4 routing tables is 16.

• The maximum number of IPv6 routing tables is 2.

• Set a gateway address when communicating with devices on an external network.

• The same gateway address is shared by all interfaces.

• "Prefixlen" is a number between 1 and 128.

rhpp

Use the "rhpp" command to view and configure RHPP settings.

View settings

msh> rhpp

Changing rhpp port number

msh> rhpp [1024-65535]

• The default is 59100.

Setting timeout

msh> rhpp timeout [30-65535]

• The default is 300 seconds.

• "RHPP" is an abbreviation of "Reliable Host Printing Protocol", which is a manufacturer-original
printing protocol.

set

Use the "set" command to set the protocol information display "active" or "inactive".

View settings

The following command displays protocol information (active/inactive).

msh> set ipv4

msh> set ipv6

msh> set appletalk
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msh> set netware

msh> set smb

msh> set protocol

• When protocol is specified, information about TCP/IP, AppleTalk, NetWare and SMB
appears.

msh> set lpr

msh> set lpr6

msh> set ftp

msh> set ftp6

msh> set rsh

msh> set rsh6

msh> set diprint

msh> set diprint6

msh> set web

msh> set snmp

msh> set ssl

msh> set ssl6

msh> set nrs

msh> set rfu

msh> set rfu6

msh> set ipp

msh> set ipp6

msh> set http

msh> set http6

msh> set bonjour

msh> set bonjour6

msh> set nbt

msh> set ssdp

msh> set ssh

msh> set sftp

msh> set sftp6

msh> set wsdev

msh> set wsdev6
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msh> set wsprn

msh> set rhpp

msh> set rhpp6

Configuration

• Enter "up" to enable protocol, and enter "down" to disable protocol.

You can set the protocol to "active" or "inactive".

msh> set ipv4 {up|down}

• If you disable IPv4, you cannot use remote access after logging off. If you did this by mistake,
you can use the control panel to enable remote access via IPv4.

• Disabling IPv4 also disables lpr, ftp, rsh, diprint, web, snmp, ssl, ipp, http, bonjour, wsdev,
and sftp.

msh> set ipv6 {up|down}

• If you disable IPv6, you cannot use remote access after logging off. If you did this by mistake,
you can use the control panel to enable remote access via IPv6.

• Disabling IPv6 also disables lpr6, ftp6, rsh6, diprint6, ssl6, ipp6, http6, bonjour 6, wsdev6,
and sftp6.

msh> set ipsec {up|down}

msh> set appletalk {up|down}

msh> set netware {up|down}

msh> set smb {up|down}

msh> set lpr {up|down}

msh> set lpr6 {up|down}

msh> set ftp {up|down}

msh> set ftp6 {up|down}

msh> set rsh {up|down}

msh> set rsh6 {up|down}

msh> set diprint {up|down}

msh> set diprint6 {up|down}

msh> set web {up|down}

msh> set snmp {up|down}

msh> set ssl {up|down}

msh> set ssl6 {up|down}

• If Secured Sockets Layer (SSL, an encryption protocol) function is not available for the printer,
you cannot use the function by enabling it.
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msh> set nrs {up|down}

msh> set rfu {up|down}

msh> set rfu6 {up|down}

msh> set ipp {up|down}

msh> set ipp6 {up|down}

msh> set http {up|down}

msh> set http6 {up|down}

msh> set bonjour {up|down}

msh> set bonjour6 {up|down}

msh> set ssh {up|down}

msh> set ssdp {up|down}

msh> set nbt {up|down}

msh> set sftp {up|down}

msh> set sftp6 {up|down}

msh> set wsdev {up|down}

msh> set wsdev6 {up|down}

• If "wsdev" and "wsdev6" are enabled simultaneously, both appear as "up" on the protocol
information display, but both use IPv4 for WS-Device and WS-Printer.

msh> set wsprn {up|down}

msh> set rhpp {up|down}

msh> set rhpp6 {up|down}

show

Use the "show" command to display network interface board configuration settings.

View settings

msh> show

• If "-p" is added, you can view settings one by one.

slp

Use "slp" command to view and configure SLP settings.

msh> slp ttl "ttl_val[1-255]"
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• You can search the NetWare server using SLP in the PureIP environment of NetWare 5/5.1. Using
the "slp" command, you can configure the value of TTL which can be used by SLP multicast packet.

• The default value of TTL is 1. A search is executed only within a local segment. If the router does not
support multicast, the settings are not available even if the TTL value is increased.

• The acceptable TTL value is between 1 and 255.

smb

Use the "smb" command to configure or delete the computer or workgroup name for SMB.

Computer name settings

msh> smb comp "computer name"

• Set computer name using up to 15 characters.

• Names beginning with "RNP" or "rnp" cannot be entered.

Working group name settings

msh> smb group "work group name"

• Set workgroup name using up to 15 characters.

Comment settings

msh> smb comment "comment"

• Set comment using up to 31 characters.

Notify print job completion

msh> smb notif {on|off}

• To notify print job completion, specify "on". Otherwise, specify "off".

Deleting computer name

msh> smb clear comp

Deleting group name

msh> smb clear group

Deleting comment

msh> smb clear comment

View protocol

msh> smb protocol

snmp

Use the "snmp" command to display and edit SNMP configuration settings such as the community name.
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View settings

msh> snmp

• Default access settings 1 is as follows:

Community name:public

IPv4 address:0.0.0.0

IPv6 address:::

IPX address:00000000:000000000000

Access type:read-only

Effective Protocol:IPv4/IPv6/IPX

• Default access settings 2 is as follows:

Community name:admin

IPv4 address:0.0.0.0

IPv6 address:::

IPX address:00000000:000000000000

Access type:read-write

Effective Protocol:IPv4/IPv6/IPX

• If "-p" is added, you can view settings one by one.

• To display the current community, specify its registration number.

Display

msh> snmp ?

Community name configuration

msh> snmp "number" name "community_name"

• You can configure ten SNMP access settings numbered 1-10.

• The printer cannot be accessed from SmartDeviceMonitor for Admin or SmartDeviceMonitor
for Client if "public" is not registered in numbers 1-10. When changing the community name,
use SmartDeviceMonitor for Admin and SNMP Setup Tool to correspond with printer settings.

• The community name can be entered using up to 15 characters.

Deleting community name

msh> snmp "number" clear name

Access type configuration

msh> snmp "number" type "access_type"

Access type Type of access permission

no not accessible
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Access type Type of access permission

read read only

write read and write

trap user is notified of trapmessages

Protocol configuration

Use the following command to set protocols "active" or "inactive": If you set a protocol "inactive",
all access settings for that protocol are disabled.

msh> snmp {ipv4|ipv6|ipx} {on|off}

• Specify "ipv4" for IPv4, "ipv6" for IPv6, or "ipx" for IPX/SPX.

• {on} means "active" and {off} means "inactive".

• All protocols cannot be turned off concurrently.

Configuration of protocol for each registration number

msh> snmp "number" active {ipv4|ipv6|ipx} {on|off}

• To change the protocol of access settings, use the following command. However, if you have
disabled a protocol with the above command, activating it here has no effect.

Access configuration

msh> snmp "number" {ipv4|ipv6|ipx} "address"

• You can configure a host address according to the protocol used.

• The network interface board accepts requests only from hosts that have IPv4, IPv6, and IPX
addresses with access types of "read-only" or "read-write". Enter "0" to have network
interface board accept requests from any host without requiring a specific type of access.

• Enter a host address to deliver "trap" access type information to.

• To specify IPv4 or IPv6, enter "ipv4" or "ipv6" followed by a space, and then the IPv4 or IPv6
address.

• To specify IPX/SPX, enter "ipx" followed by a space, the IPX address followed by a decimal,
and then the MAC address of the network interface board.

sysLocation configuration

msh> snmp location

Deleting sysLocation

msh> snmp clear location

sysContact setting

msh> snmp contact
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Deleting sysContact

msh> snmp clear contact

SNMP v1v2 function configuration

msh> snmp v1v2 {on|off}

• Specify "on" to enable, and "off" to disable.

SNMP v3 function configuration

msh> snmp v3 {on|off}

• Specify "on" to enable, and "off" to disable.

SNMP TRAP configuration

msh> snmp trap{v1|v2|v3} {on|off}

• Specify "on" to enable, and "off" to disable.

Remote Configuration Authorization configuration

msh> snmp remote {on|off}

• Specify "on" to enable, and "off" to disable the SNMP v1v2 setting.

SNMP v3 TRAP configuration display

msh> snmp v3trap

msh> snmp v3trap [1-5]

• If a number from 1 to 5 is entered, settings are displayed for that number only.

Configuring a sending address for SNMP v3 TRAP

msh> snmp v3trap [1-5] {ipv4|ipv6|ipx} "address"

Configuring a sending protocol for SNMP v3 TRAP

msh> snmp v3trap [1-5] active {ipv4|ipv6|ipx} {on|off}

Configuring a user account for SNMP v3 TRAP

msh> snmp v3trap [1-5] account "account_name"

• Enter an account name using up to 32 alphanumeric characters.

Deleting an SNMP v3 TRAP user account

msh> snmp v3trap [1-5] clear account

Configuring an SNMP v3 encryption algorithm

msh> snmp v3auth {md5|sha1}

Configuring SNMP v3 encryption

msh> snmp v3priv {auto|on}

• Set "auto" for automatic encryption configuration.
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• If you select "on", plain-text communication becomes impossible - only encrypted
communication is possible.

• "Encrypted communication" means an encrypted password is set on the machine.

sntp

The printer clock can be synchronized with a NTP server clock using Simple Network Time Protocol
(SNTP). Use the "sntp" command to change SNTP settings.

View settings

msh> sntp

NTP IPv4 server address configuration

You can specify the IPv4 address of the NTP server.

msh> sntp server "IPv4_address"

NTP hostname configuration

You can specify the hostname of the NTP server.

msh> sntp server "hostname"

Deleting NTP server configuration

msh> sntp server clear

Interval configuration

msh> sntp interval "polling_time"

• You can specify the interval at which the printer synchronizes with the operator-specified NTP
server. The default is 60 minutes.

• The interval can be entered from 0, or between 15 and 10,080 minutes.

• If you set 0, the printer synchronizes with the NTP server only when you turn the printer on.
After that, the printer does not synchronize with the NTP server.

Time-zone configuration

msh> sntp timezone "±hour_time"

• You can specify the time difference between the printer clock and NTP server clock. The
values are between -12:00 and +13:00.

• You can only select either the address or host name for the ntp server.
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spoolsw

Use the "spoolsw" command to view and configure Job Spool settings.

You can only specify diprint, trap, lpr, ipp, ftp, sftp, ws-printer, and smb (TCP/IP) protocol.

• The "spoolsw" command for configuring Job Spool settings is available only when the optional
hard disk is installed.

View settings

The Job Spool setting appears.

msh> spoolsw

Job Spool setting

msh> spoolsw spool {on|off}

• Specify "on" to enable Job Spool, or "off" to disable it.

Resetting Job spool setting

msh> spoolsw clear job {on|off}

• When the printer power is cut during job spooling, this determines whether to reprint the
spooled job.

Protocol configuration

msh> spoolsw diprint {on|off}

msh> spoolsw lpr {on|off}

msh> spoolsw ipp {on|off}

msh> spoolsw smb {on|off}

msh> spoolsw ftp {on|off}

msh> spoolsw sftp {on|off}

msh> spoolsw {on|off}

ssdp

Use the "ssdp" command to view and configure SSDP settings.

View settings

msh> ssdp

Setting effective time

msh> ssdp profile [1801-86400]

The default is 10800 seconds.
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Advertise packet TTL settings

msh> ssdp ttl [1-255]

The default is 4.

ssh

Use the "ssh" command to view and configure SSH settings.

View settings

msh> ssh

Data compression communication settings

msh> ssh compression {on|off}

The default is "on".

SSH/SFTP communication port setting

msh> ssh port [22, 1024-65535]

The default is 22.

SSH/SFTP communication timeout setting

msh> ssh timeout [0-65535]

The default is 300.

SSH/SFTP communication login timeout setting

msh> ssh logintimeout [0-65535]

The default is 300.

Setting an open key for SSH/SFTP

msh> ssh genkey {512|768|1024} "character string"

Create an open key for SSH/SFTP communication.

Usable characters are ASCII 0x20-0x7e (32 bytes) other than "0".

The default key length is 1024, and the character string is blank.

If you do not specify this parameter, an open key with the default value will be created.

Deleting open key for ssh/sftp communication

msh> ssh delkey

• If you do not specify a character string, current setting is displayed.
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status

Use the "status" command to display the printer status.

view messages

msh> status

syslog

Use the "syslog" command to display the information stored in the printer's system log.

View message

msh> syslog

upnp

Use the "upnp" command to display and configure the universal plug and play.

Public URL display

msh> upnp url

Public URL configuration

msh> upnp url "string"

• Enter the URL string in the character string.

web

Use the "web" command to display and configure parameters on Web Image Monitor.

View Settings

msh> web

URL Configuration

You can set URLs linked by clicking [URL] on Web Image Monitor.

msh> web "ID" url http:// "The URL or IP address you want to register"/

Specify "1" or "2" for ID as the number corresponding to the URL. Up to two URLs can be registered
and specified.

Resetting URLs registered as link destinations

msh> web "ID" clear url

Specify "1" or "2" for ID as the corresponding number to the URL.
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Link name configuration

You can enter the name for URL that appears on Web Image Monitor.

msh> web "ID" name "Name you want to display"

Specify "1" or "2" for ID the corresponding number to the link name.

Resetting URL names registered as link destinations

msh> web "ID" clear name

Specify "1" or "2" for ID as the number corresponding to the link name.

Help URL Configuration

You can set URLs linked by clicking "?" on Web Image Monitor.

msh> web help http://"Help URL or IP address"/help/

Resetting Help URL

msh> web clear help

wiconfig

Use the "wiconfig" command to make settings for IEEE 802.11.

View settings

msh> wiconfig

View IEEE 802.11 settings

msh> wiconfig cardinfo

• If IEEE 802.11 is not working correctly, its information is not displayed.

Configuration

msh> wiconfig "parameter"

Parameter Value configured

mode {ap|802.11adhoc} You can set the infrastructure mode (ap) or the
802.11 Ad hoc mode (802.11adhoc).

The default is the infrastructure mode.

ssid "ID value" You can specify an SSID in infrastructure
mode. The characters you can enter in the
SSID string are ASCII 0x20-0x7e (32 bytes). If
you do not specify a character string, the
machine will connect to the nearest access
point.

The default SSID is blank.
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Parameter Value configured

channel frequency "channel no." In 802.11 ad hoc mode, you can select a
channel between 1 and 14, or 36, 40, 44, or
48.

Be sure to set the same channel for all ports
that will transmit and receive data.

The default is "11".

key "key value" val [1|2|3|4] You can specify the WEP key when entering in
hexadecimal.

With a 64-bit WEP, you can use 10 digit
hexadecimals. With a 128-bit WEP, you can
use 26 digit hexadecimals.

Up to four WEP keys can be registered.
Specify the number to be registered with "val".

When a WEP is specified by key, the WEP
specified by key phrase is overwritten.

To use this function, set the same key number
and WEP key for all ports that transmit data to
each other. Put "0x"on the front of WEP key.

You can omit the numbers with "val". The key
number is set to 1 when making these
omissions. The default is blank.

keyphrase "phrase" val [1|2|3|4] You can specify the WEP key when entering in
ASCII.

With a 64-bit WEP, you can use 5 digit
hexadecimals. With a 128-bit WEP, you can
use 13 digit hexadecimals.

Up to four WEP keys can be registered.
Specify the number to be registered with "val".

When a WEP is specified by key phrase, the
WEP specified by key is overwritten.

To use this function, set the same key number
and WEP key for all ports that transmit data to
each other.

You can omit the numbers with "val". The key
number is set to1 when making these
omissions. The default is blank.
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Parameter Value configured

encval [1|2|3|4] You can specify which of the four WEP keys is
used for packet encoding. "1" is set if a number
is not specified.

wepauth {open|shared} You can set an authorization mode when using
WEP. The specified value and authorized
mode are as follows:

open: open system authorized (default)

shared: shared key authorized rate

security {none|wep|wpa} You can specify the security mode.

none: No encryption(default)

wep: WEP encryption

wpa: WPA encryption

wpaenc {tkip|ccmp} You can specify WPA encryption key when
using WPA encryption.

tkip: TKIP

ccmp: CCMP (AES) (default)

wpaauth {wpapsk|wpa|wpa2psk|wpa2} You can specify the WPA authentication mode
when using WPA encryption.

wpapsk: WPA-PSK authentication(default)

wpa: WPA authentication

wpa2psk: WPA2-PSK authentication

wpa2: WPA2 authentication

psk "character string" You can specify the Pre-Shared key.

Usable characters: ASCII 0x20-0x7e (8 to 63
bytes).

The default is blank.
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Parameter Value configured

eap {tls|ttls|leap|peap} {chap|mschap|
mschapv2|pap|md5|tls}

You can specify the EAP authentication type.

tls: EAP-TLS (default)

ttls: EAP-TTLS

leap: LEAP

peap: PEAP

chap, mschap, mschapv2, pap, md5, or tls are
settings for the phase 2 method, and must be
set when using EAP-TTLS or PEAP.

Do not make these settings when using other
EAP authentication types.

If you select EAP-TTLS, you can select chap,
mschap, mschapv2, pap, or md5.

If you select PEAP, you can select mschapv2 or
tls.

username "character string" You can specify the login user name for the
Radius server.

Usable characters: ASCII 0x20-0x7e (31
bytes).

The default is blank.

username2 "character string" You can specify the phase 2 username for
EAP-TTLS/PEAP phase 2 authentication.

Usable characters: ASCII 0x20-0x7e (31
bytes).

The default is blank.

domain "character string" You can specify the login domain name for the
Radius server.

The characters you can enter are ASCII
0x20-0x7e (31 bytes), but not "@" or "\".

The default is blank.

password "character string" You can specify the login for the Radius server.

Usable characters: ASCII 0x20-0x7e (128
bytes). The default is blank.
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Parameter Value configured

srvcert {on|off} You can set the server certificate. The default is
"off".

imca {on|off} You can enable or disable the certificate when
the intermediate certificate authority is present.
The default is "off".

srvid "character string" You can set the server ID and subdomain of the
certificate server.

Usable characters: ASCII 0x20-0x7e(128
bytes). The default is blank.

connectinfo Obtains connection information.

claer {a each command|all} Returns the selected setting to its default value.

If you specify "all", all settings will be restored
to their default values.

miccheck {on|off} You can enable or disable the MIC check
function.

The default setting is "On" (enabled).

If you specify "Off", you cannot perform MIC
checks. We recommend you specify "On" for
the MIC check function when using this
machine.

wins

Use the "wins" command to configure WINS server settings.

Viewing settings

msh> wins

• If the IPv4 address obtained from DHCP differs from the WINS IPv4 address, the DHCP
address is the valid address.

Configuration

msh> wins "interface_name" {on|off}

• {on} means "active" and {off} means "inactive".

• Be sure to specify the interface.

• wlan can be specified only when the IEEE 802.11 interface is installed.
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Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11 interface

Address configuration

Use the following command to configure a WINS server IP address:

wins "interface_name" {primary|secondary} "IP address"

• Use the "primary" command to configure a primary WINS server IP address.

• Use the "secondary" command to configure a secondary WINS server IP address.

• Do not use "255.255.255.255" as the IP address.

NBT (NetBIOS over TCP/IP) Scope ID Selection

You can specify the NBT scope ID.

msh> wins "interface_name" scope "scope ID"

• The scope ID can be entered using up to 31 alphanumeric characters.

• Be sure to specify the interface.

• wlan can be specified only when the IEEE 802.11 interface is installed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11 interface

wsmfp

Use the "wsmfp" command to view and configure WS-MFP settings.

Viw settings

msh> wsmfp

Comment settings

msh> wsmfp comments "comment"

• If you do not specify a comment, current setting is displayed.

Location configuration

mah> wsmfp location "location"

• If you do not specify a comment, current setting is displayed.
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Presentation URL configuration

msh> wsmfp url "URL"

• Ebter the URL string in the "URL".

WS-Device TCP port configuration

msh> wsmfp devport "port_number"

• The Default is 53000.

WS-Printer TCP port configuration

msh> wsmfp prnport "port_number"

• The Default is 53001.

Timeout configuration

msh> wsmfp prntimeout [30-65535]

• The default is 900 seconds.

Comment initialization

msh> wsmfp clear comments

Location initialization

msh> wsmfp clear location

Presentation URL initialization

msh> wsmfp clear url
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SNMP
Using the SNMP manager, you can get information about the machine.

The SNMP agent operating on UDP and IPX is incorporated into the built-in Ethernet board and optional
IEEE 802.11 interface unit of this machine.

This machine also supports SNMPv3, which increases user authentication, data encryption, and access
control security.

To encrypt communication by SNMPv3, you must specify the machine's encrypted password.

• If you changed the machine's community name, change the configuration of the connected
computer accordingly, using SNMP Setup Tool. For details, see SNMP Setup Tool Help.

The default community names are [public] and [admin]. You can get MIB information using these
community names.

Start SNMP Setup Tool

• Windows 2000:

Click the [Start] button.

Point to [SmartDeviceMonitor for Admin] on the [Programs] menu.

Click [SNMP Setup Tool].

• Windows XP/Vista:

Click the [Start] button.

Point to [SmartDeviceMonitor for Admin] on the [All Programs] menu.

Click [SNMP Setup Tool].

Supported MIBs(SNMPv1/v2)

• MIB-II

• PrinterMIB

• HostResourceMIB

• IPv6-TCP-MIB

• IPv6-UDP-MIB

• IPv6-MIB

• IPv6-ICMP-MIB

• RicohPrivateMIB

Supported MIBs(SNMPv3)

• MIB-II

• PrinterMIB
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• HostResourceMIB

• IPv6-TCP-MIB

• IPv6-UDP-MIB

• IPv6-MIB

• IPv6-ICMP-MIB

• RicohPrivateMIB

• SNMP-FRAMEWORK-MIB

• SNMP-TARGET-MIB

• SNMP-NOTIFICATION-MIB

• SNMP-USER-BASED-SM-MIB

• SNMP-VIEW-BASED-ACM-MIB
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Getting Printer Information over the Network
This section explains details of each item displayed in the printer status and information.

Current Printer Status

This section explains how you can check the machine's status and the items displayed. Depending on the
options installed on the machine, some items might not be displayed.

• UNIX: Use the “lpq” command and “rsh”, “rcp”, “ftp”, and “sftp” parameters.

• mshell: Use the “status” command.

Messages Description

Access Restricted The job was canceled because user have no
authority.

Adjusting... The machine is initializing or calibrating.

Call Service Center There is a malfunction in the machine.

Canceled The job is reset.

Canceling Job... The job is being reset.

Cannot Eject Original Through The original cannot be ejected.

Cannot multi-install: SD Card SD Card software cannot be installed multi times.

Card/Counter not inserted The machine is waiting for prepaid card or key.

Coin or amount not inserted The machine is waiting for coin to be inserted.

Coin/Key Counter not inserted The machine is waiting for coin or key counter.

Configuring... Setting is being changed.

Cooling Down Fusing Unit... The fusing unit is cooling down.

Cover Open: Finisher cover The cover of folding finisher is open.

Cover Open: Front Cover The front cover is open.

Cover Open: Mainframe The mainframe cover is open.

Cover Open: Exit The paper exit cover is open.
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Messages Description

Data Size Error The data size error occurred.

Empty: Black Toner The black toner cartridge is almost empty.

Energy Saver Mode The machine is in Energy Saver Mode.

Envelope Setting Error: None Printing paper type other than envelope is
instructed when B2 lever is down.

Envelope Setting Error: Others Printing envelope is instructed when B2 lever is
down.

Error An error has occurred.

Error: Address Book An error has occurred in the data of the address
book.

Error: Command Transmission An error has occurred in the machine.

Error: DIMM Value A memory error occurred.

Error: Ethernet Board An Ethernet board error has occurred.

Error: HDD Board A hard disk drive board error has occurred.

Error: Media Link Board An error has occurred on the media link board.

Error: Memory Switch A memory switch error has occurred.

Error: Optional Font An error has occurred in the font file of the
machine.

Error: Optional RAM An error has occurred in the optional memory
unit.

Error: Parallel I/F Board An error has occurred in the parallel interface.

Error: PDL An error has occurred in the page description
language.

Error: Rem. Certificate Renewal An error has occurred in the remote sever
renewal.

Error: USB Board An error has occurred in the USB interface board.

Error: USB Interface An error has occurred in the USB interface.
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Messages Description

Error: Wireless Card IEEE 802.11a/g interface unit is taken out after
start up.

Exceed Stapling Limit The printing has exceeded the stapling limit.

Fold-Fin. Stamper not put back The folding finisher stamper is not put back to its
place.

Full: Finisher Finisher tray is full.

Full: Finisher Shift Tray Shift tray of Finisher is full.

Full: Front Paper Exit Front paper exit is full.

Full: Log Data Capacity The log data capacity is full.

Full: Shift Tray Shift tray is full.

Full: Waste Toner Waste toner is full.

Hex Dump Mode It is a hex dump mode.

Immed. Trans. not connected It did not connect directly with the other party of
the transmission.

Immediate Transmission Failed An error has occurred while transmitting directly.

Independent-supplier Toner Toner that is not recommended is set.

In Use: Copier The copier is being used.

In Use: Finisher Other function is using Finisher.

In Use: Input Tray Other function is using the input tray.

Jobs Suspended All jobs are suspended.

Key Card not inserted The machine is waiting for key card to be
inserted.

Key Card/Counter not inserted The machine is waiting for key card or key
counter to be inserted.

Key Counter not inserted The machine is waiting for key counter to be left
in it.

Loading Toner... Toner is being supplied.
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Messages Description

Log Data Transfer failed Log transfer has failed.

Low: Black Toner The black toner cartridge is not set correctly, or
toner is almost running out.

Low: Toner The toner cartridge is not set correctly, or toner is
almost running out.

Malfunction: Ext. Charge Unit There is a problem with the external charge unit.

Malfunction: Finisher There is a problem with the finisher.

Malfunction: Lower Paper Tray(s) There is a problem with the bank motor.

Malfunction: Output Tray There is a problem with the output tray.

Malfunction: Tray 1(Paper Roll 1) There is a problem with tray 1 (Paper Roll 1).

Malfunction: Tray 2(Paper Roll 2) There is a problem with tray 2 (Paper Roll 2).

Malfunction: Tray 3(Cut Paper 1) There is a problem with tray 3 (Cut Paper 1).

Malfunction: Tray 3(Paper Roll 3) There is a problem with tray 3 (Paper Roll 3).

Malfunction: Tray 4(Cut Paper 2) There is a problem with tray 4 (Cut Paper 2).

Malfunction: Tray 4(Paper Roll 4) There is a problem with tray 4 (Paper Roll 4).

Memory Low: Copy Memory shortage has occurred while the copy
was operating.

Memory Low: Data Storage Memory shortage has occurred while the
document was being accumulated.

Memory Low: Scanning Memory shortage has occurred while the scanner
was working.

Miscellaneous Error Other error has occurred.

Mismatch: Paper Size Indicated paper tray does not contain paper of
selected size.

Mismatch: Paper Size and Type Indicated paper tray does not contain paper of
selected size and type.

Mismatch: Paper Type Indicated paper tray does not contain paper of
selected type.
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Messages Description

Near Replacing: Black PCU Prepare the new black photoconductor unit.

Near Replacing: Develop. Unit K Prepare the new development unit (black).

Near Replacing: Fusing Unit Prepare the new fusing unit.

Nearly Full: Log Data Capacity The log is nearing data capacity.

Nearly Full: Waste Toner Waste toner bottle is nearly full.

No Paper: Tray 1(Paper Roll 1) There is no paper in tray 1 (Paper Roll 1).

No Paper: Tray 2(Paper Roll 2) There is no paper in tray 2 (Paper Roll 2).

No Paper: Tray 3(Cut Paper 1) There is no paper in tray 3 (Cut Paper 1).

No Paper: Tray 3(Paper Roll 3) There is no paper in tray 3 (Paper Roll 3).

No Paper: Tray 4(Cut Paper 2) There is no paper in tray 4 (Cut Paper 2).

No Paper: Tray 4(Paper Roll 4) There is no paper in tray 4 (Paper Roll 4).

Not Detected: Black Toner Black toner is not correctly set.

Not Detected: Finisher Finisher is not correctly set.

Not Detected: Fusing Unit The fusing unit is not correctly set.

Not Detected: Input Tray The paper feed tray is not correctly set.

Not Detected: PCU (K) The photoconductor unit (black) is not correctly
set.

Not Detected: Tray 1(Paper Roll 1) Tray 1 (Paper Roll 1) is not correctly set.

Not Detected: Tray 2(Paper Roll 2) Tray 2 (Paper Roll 2) is not correctly set.

Not Detected: Tray 3(Cut Paper 1) Tray 3 (Cut Paper 1) is not correctly set.

Not Detected: Tray 3(Paper Roll 3) Tray 3 (Paper Roll 3) is not correctly set.

Not Detected: Tray 4(Cut Paper 2) Tray 4 (Cut Paper 2) is not correctly set.

Not Detected: Tray 4(Paper Roll 4) Tray 4 (Paper Roll 4) is not correctly set.

Not Detected: WasteToner Bottle Waste toner bottle is not correctly set.

Not Reached, Data Deleted Unreached job is deleted.
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Messages Description

Not Reached, Data Stored Unreached documents are saved.

Offline Machine is offline.

Operating Thermo-range Error The machine is operating outside the permissible
temperature range.

Panel Off Mode The machine is in Panel-Off mode.

Panel Off Mode>>Printing ava. The machine is in Control Panel-Off mode.

Paper Error: Remaining in Bypass Since paper is loaded in the bypass tray, the
document can not be printed from the paper
trays.

Paper in Finisher The paper remains in Finisher.

Paper Misfeed: Finisher The paper has jammed in folding finisher.

Paper Misfeed: Internal/Output The paper has jammed in the internal or output
tray.

Paper Misfeed: Paper Tray The paper has jammed in the paper tray.

Prepaid Card not inserted The prepaid card is not inserted, or has
insufficient credit.

Print Complete The print was completed.

Printing... Printing is in progress.

Processing Data is being processed.

Proxy Address / Port Incorrect The proxy address and port setting is incorrect.

Proxy User / Password Incorrect The proxy user name and password setting is
incorrect.

Ready The machine is ready to print.

Renewing Remote Certificate The remote certificate is being renewed.

Replace Black PCU It is time to replace the black photoconductor unit.

Replace Charger Kit It is time to replace the charger kit.

Replace Cleaning Web It is time to replace the Cleaning Web.
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Messages Description

Replace Develop. Unit It is time to replace the development unit.

Replace Develop. Unit (Black) It is time to replace the development unit (black).

Replace Fusing Unit It is time to replace the fusing unit.

Replace Int. Transfer Unit It is time to replace the transfer unit.

Replace Transfer Cleaning Unit It is time to replace the transfer cleaning unit.

Reset IPDS fonts The IPDS fonts are being reset.

Retarding... Printing has stopped momentarily to allow printed
sheets to dry.

SD Card Authentication failed SD card authentication failed.

SD Card not inserted The machine is waiting for SD card.

Setting Remotely The RDS setting is being processed.

Skipped due to Error Skipped the error.

Storage Complete The storage is complete.

Storage Failed The storage has failed.

Supplies Order Call failed The supply order call has failed.

Suspend / Resume Key Error Finisher stop button was pressed.

Transmission Aborted The transmission was interrupted.

Transmission Complete The transmission completion was completed.

Transmission Failed The transmission has failed.

Tray Error: Chaptering The paper feed tray specification error has
occurred because chaptering as well as the
normal paper use the same tray for printing.

Waiting for Job Suspension The machine is waiting for Job Suspension.

Warming Up... The machine is warming up.

• For details about UNIX commands, see UNIX Supplement.
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• Check the error contents that may be printed in the configuration page. For details about printing a
configuration page, see “Printing the Configuration Page”, General Settings Guide.

Printer configuration

You can check the printer configuration using telnet.

This section explains the checking procedure for input/output tray and printer language.

• UNIX: Use the “info” command and “rsh”, “rcp”, “ftp”, and “sftp” parameters.

• mshell: Use the “info” command.

Input Tray

Item Description

No. ID number of the paper tray

Name Name of the paper tray

PaperSize Size of paper loaded in the paper tray

Status Current status of the paper tray

• Normal: Normal

• NoInputTray: No tray

• PaperEnd: No paper

Output Tray

Item Description

No. ID number of the output tray

Name Name of the output tray

Status Current status of the output tray

• Normal: Normal

• PaperExist: Paper exist

• OverFlow: Paper is full

• Error: Other errors
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Printer Language

Item Description

No. ID number of the printer language used by the
printer

Name Name of the printer language used in the printer

Version Version of the printer language

• For details about UNIX commands and parameters, see UNIX Supplement.
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Understanding the Displayed Information
This section explains how to read status information returned by the network interface board.

Print Job Information

Use the following command to display print job information:

• UNIX: Use the “info” command and “rsh”, “rcp”, “ftp”, and “sftp” parameters.

• mshell: Use the “info” command.

Item Description

Rank Print job status.

• Active

Printing or preparing for printing.

• 1st, 2nd, 3rd, 4th...

Waiting to be transferred to the printer.

Owner Print request user name.

Job Print request number.

Files The name of the document.

Total Size The size of the data (spooled).

The default is 0 bytes.

• For details about UNIX commands and parameters, see UNIX Supplement.

Print Log Information

This is a record of the most recent jobs printed.

Use the following command to display print log information:

• UNIX: Use the “prnlog” command and “rsh”, “rcp”, “ftp”, and “sftp” parameters.

• telnet : Use the “prnlog” command.
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Item Description

ID Print request ID.

User Print request user name.

Page Number of pages printed

Result Print Request Result

Communication Result

• OK

Print was completed normally. However, the
print result may not be as required due to
printer problems.

• NG

Printing was not completed normally.

• Canceled

An “rcp”, “rsh”, or “lpr” command print
request was canceled, possibly due to the
printing application. Not applicable to the
“ftp” or “rprinter” command.

Time Time the print requested was received.

Time of print request reception

User ID (when designating Job ID on telnet) Printer driver-configured User ID.

Appears when the print request ID is specified.

JobName (when designating Job ID on telnet) Name of the document for printing

Appears when the print request ID is specified.

• For details about UNIX commands and parameters, see UNIX Supplement.

Configuring the Network Interface Board

Use the following command to display network interface board settings:

• telnet : Use the “show” command.
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Item Description

Common

Mode

Protocol Up/Down Protocol Settings

AppleTalk

IPv4

IPv6

IPsec

NetWare

SMB

Device Up/Down Device Settings

Parallel

USB

Ethernet interface

Syslog priority

NVRAM version

Device name

Comment

Location

Contact

Soft switch

AppleTalk AppleTalk settings

Mode

Net

Object

Type
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Item Description

Zone

TCP/IP TCP/IP settings

Mode(IPv4)

Mode(IPv6)

ftp

lpr

rsh

telnet

diprint

web

http

ftpc

snmp

ipp

autonet

bonjour

ssl

nrs

rfu

nbt

ssdp

ssh

sftp

WS-Device

WS-Print
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Item Description

rhpp

IPv4

DHCP

Address

Netmask

Broadcast

Gateway

IPv6

Stateless

Manual

Gateway

EncapType

DHCPv6-lite

DUID

DHCPv6 option lifetime

IPsec

Manual Mode

Excluded Protocol

https

dns

dhcp

wins

EncapType

Host name

DNS Domain
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Item Description

Access Control Access Control settings

IPv4 X can be set between 1 and 5.

AccessEntry[X]

IPv6

AccessEntry[X] X can be set between 1 and 5.

SNTP Server Time settings

Time Zone

SNTP Server polling time

SYSLOG server Websys settings

Home page URL1

Home page linkname1

Home page URL2

Home page linkname2

Help page URL

IPDS Port

IPDS timeout

RHPP Port

RHPP timeout

NetWare

EncapType

RPRINTER number

Print server name

File server name

Context name

Switch
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Item Description

Mode

NDS/Bindery

Packet negotiation

Login Mode

Print job timeout

Protocol

SAP interval time

NDS Tree Name

Transfer Protocol

SMB SMB settings

Switch

Mode

Direct print

Notification

Workgroup name

Computer name

Comment

Share name[1]

Protocol

Wireless LAN Wireless LAN settings

Communication Mode

SSID

Channel

Security

WEP Authentication
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Item Description

WEP Encryption key number

WEP Encryption key number [X] X can be set between 1 and 4.

WEP Encryption

WPA Encryption

WPA Authentication

Pre-Shared Key

User name

Domain name

EAP Type

Password

Phase 2 user name

Phase 2 Method TTLS

Phase 2 Method PEAP

Server cert.

IntermediateCA

Server ID

Sub domain

MIC check

DNS DNS settings

IPv4

Server[X] X can be set between 1 and 3.

Selected IPv4 DNS Server

IPv6

Server[X] X can be set between 1 and 3.

Selected IPv6 DNS Server
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Item Description

Resolver Protocol

Domain Name

ether

wlan

DDNS

ether

wlan

WINS WINS settings

ether

Primary WINS

Secondary WINS

wlan

Primary WINS

Secondary WINS

SSDP SSDP settings

UUID

Profile

TTL

UPnP UPnP settings

URL

Bonjour Bonjour (Redezvous) settings

Computer Name (cname)

Local Hostname (ether)

Local Hostname (wlan)

Location
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Item Description

Priority (diprint)

Priority (lpr)

Priority (ipp)

IP TTL

LinkLocal Route for MultiI/F

IPP Port

SNMP SNMP settings

SNMPv1v2

SNMPv3

protocol

v1Trap

v2Trap

v3Trap

SNMPv1v2 Remote Setting

SNMPv3 Privacy

ssh ssh settings

Compression

Port

TimeOut

Login TimeOut

AuthFree Authfree settings

IPv4

AuthFreeEntry[X] X can be set between 1 and 5.

IPv6

AuthFreeEntry[X] X can be set between 1 and 5
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Item Description

Parallel

USB

LPR

lprm check host

lpr prnerr chk

Certificate

Verification

WS-MFP

Network Device Name

Comments

Location

Presentation URL

WS-Device TCP Port

WS-Printer TCP Port

WS-Printer Job Timeout

MetadataVersion

UUID

Shell mode Remote maintenance tool mode

Understanding the Displayed Information
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Message List
This is a list of messages that appear in the machine's system log. The system log can be viewed using
the "syslog" command.

System Log Information

Use the following command to display the system log information:

• UNIX: Use the "syslog" command and "rsh", "rcp", "ftp", and "sftp" parameters.

• telnet: Use the "syslog" command.

Message Problem and solutions

account is unavailable:

Same account name be used.

User account is disabled. This could be because it
use the same account name as the administrator
account.

account is unavailable:

The authentication password is not set up.

User account is disabled. This could be because
the authentication password is not set, and only
the encryption account is set.

account is unavailable:

encryption is impossible.

Encryption is not possible and account is
disabled. This could be because:

• Security option is not installed.

• Encryption password has not been specified.

add_sess_IPv4: bad trap <IPv4 address>
community <community name>

The IPv4 address (0.0.0.0.) is unavailable when
the community access type is TRAP. Specify the
host IPv4 address for the TRAP destination.

add_sess_IPv6: bad trap <IPv6 address>
community <community name>

The IPv6 address [::] is unavailable when the
community access type is TRAP. Specify the host
IPv6 address for the TRAP destination.

add_sess_IPv4: community <community name>
already defined.

The same community name already exists. Use
another community name.

add_sess_IPv6: community <community name>
already defined.

The same community name already exists. Use
another community name.

2. Monitoring and Configuring the Printer
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Message Problem and solutions

add_sess_IPX: bad trap <IPX address>
community <community name>

The IPX address (00:00:00:00:00:00) is
unavailable when the community access type is
TRAP. Specify the host IPX address for the TRAP
destination.

add_sess_ipx: community <communityname>
already defined.

The same community name already exists. Use
another community name.

adjust time server <NTP server name> offset: xx
sec.

ncsd tells you the timing of the NTP server and
whether or not the time system clock is set.

NTP Server: NTP server name

offset: number of seconds of delay (minus number
if a time in advance is specified)

authenticated The supplicant is authenticated.

authenticating The supplicant is authenticating with the access
point (EAP or WPA).

Authentication mode mismatch The authentication mode of the access point is
different from the authentication mode of the
supplicant.

Use the authentication mode between the access
point and the supplicant.

Client EAP method rejected The authentication mode of the access point is
different with the authentication mode of the
supplicant.

Use the same authentication mode between the
access point and the supplicant.

Client password rejected The client's password was rejected. Check the
client password.

Client TLS certificate rejected The client's TLS certificate was rejected. Check the
certificate.

cipher suite mismatch The uni-cast / multi-cast suite (TKIP/AES/WEP)
of the access point is different from the suite used
by the supplicant.

connecting The supplicant is waiting for wireless connection
to the access point.
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Message Problem and solutions

Current Interface Speed: xxxMbps Speed of the network (10Mbps, 100 Mbps, or
1Gbps).

Duplicate IP = <IP address> (from <MAC
address>).

The same IP address (IPv4, or IPv6 address) was
used. Each IP address (IPv4, or IPv6 address)
must be unique. Check the address of the device
indicated in [MAC address].

IEEE 802.11 Card does NOT support WPA . A wireless card that does not support WPA is
installed. Install a wireless card that supports
WPA.

IEEE 802.11 Card Firmware REV.<version> Displays the version number of the 802.11 card's
firmware.

IEEE 802.11 card removed The wireless card managed by the supplicant has
been removed.

IEEE 802.11 current channel <channel nember> Displays the current channel number of the active
wireless card (in ad hoc and infrastructure mode).

IEEE 802.11 interface down The IEEE 802.11 interface managed by the
supplicant is disabled, or cannot connect to the
access point.

IEEE 802.11 interface up The IEEE 802.11 interface managed by the
supplicant is enabled, or is connected to the
access point.

IEEE 802.11 MAC Address = <MAC address> Displays the MAC address of the wireless
interface.

IEEE 802.11 SSID <ssid> (AP MAC Address
<MAC address>)

The MAC address and SSID of the access point
are connected in infrastructure mode.

IEEE 802.11 <communication mode> mode Displays IEEE 802.11 communication mode.

inetd start. The inetd service has started.

Interface (interface name): Duplicate IP Address
(<IP address>).

The same IP (IPv4 or IPv6) address was used.
Each IP address must be unique. Check the
address of the device indicated in [IP address].

< Interface > started with IP: < IP address > IP address (IPv4 or IPv6 address) has been set for
the interface and is operating.

2. Monitoring and Configuring the Printer
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Message Problem and solutions

< Interface >: Subnet overlap. The same IP address (IPv4, orIPv6 address) and
the subnet mask is used with other device.

LEAP challenge to access point failed The LEAP challenge to the access point has failed.

MIC failure TKIP counter measures started The supplicant using TKIP has detected two
instances of tampering within 60 seconds and has
started counter measures.

MIC failure TKIP counter measures stopped Counter measures have stopped after 60 seconds
(since the supplicant using TKIP started counter
measures against tampering).

no RADIUS/authentication server The supplicant has received a message reporting
that a usable RADIUS server cannot be found.

no smart card detected on device PEAP/GTC (Generic Token Card) is selected, but
a smart card using GTC authentication cannot be
found.

no WPA information element in probe response,
rescanning

There is no WPA information on the response
from the SSID probe of the access point you want
to use. The supplicant is rescanning.

server certificate invalid The server ID is disabled. Check the server
authentication.

server identity invalid The server ID is disabled. Check the server
authentication.

server not trusted The RADIUS server cannot be trusted.

session IPv4 <community name> not defined. The requested community name is not defined.

session IPv6 <community name> not defined. The requested community name is not defined.

session_ipx <community name> not defined. The requested community name is not defined.

shutdown signal received. network service
rebooting...

The smbd service has started.

Message List
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Message Problem and solutions

SMTPC: failed to get smtp server ip-address. The SMTP server IP address could not be
obtained. This could be because:

• The specified DNS server could not be
found.

• No connection to the network has been
established.

• The specified DNS server could not be
found.

• An incorrect DNS server is specified.

• The specified SMTP server IP address could
not be found in the DNS server.

SMTPC: failed to connect smtp server. timeout. Connection to the SMTP server failed due to
timeout. This could be because the specified
SMTP server name is incorrect, or no connection
to the network has been established, or the
network configuration is incorrect, so there is no
response from the SMTP server. Check the SMTP
server name, or the network connection and
configuration.

SMTPC: refused connect by smtp server. Connection to the SMTP server is denied. This
could be because server other than the SMTP
server has been specified, or the specified SMTP
server port number is incorrect. Check the SMTP
server name, port number, or the SMTP server
port number.

SMTPC: no smtp server. connection close. Connection to the SMTP server failed due to no
response from SMTP. This could be because a
server other than the SMTP server has been
specified, or the specified SMTP server port
number is incorrect. Check the SMTP server
name, port number, or the SMTP server port
number.
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Message Problem and solutions

SMTPC: failed to connect smtp server. Connection to the SMTP server failed. This could
be because no connection to the network has
been established, or the network configuration is
incorrect, so there is no response from the SMTP
server, or the specified SMTP server name is
incorrect, or the specified SMTP server IP address
could not be found in the DNS server, or a server
other than the SMTP server has been specified, or
the specified SMTP server port number is
incorrect. Check the DNS Server's IP address and
SMTP server's IP address, or the SMTP server
name and SMTP port number, or the SMTP
server's SMTP port number, or the network
connection and configuration.

SMTPC: username or password wasn't correct.
[response code] (information)

Connection to the SMTP server failed, because
the specified SMTP user name is incorrect, or the
specified SMTP password is incorrect. Check the
SMTP user name and password.

Snmp over IPv4 is ready Communication over IPv4 with snmp is available.

Snmp over IPv6 is ready. Communication over IPv6 with snmp is available.

Snmp over ipx is ready. Communication over IPX with snmp is available.

snmpd start. The snmpd service has started.

started. The direct print service has started.

Started. The bonjour (rendezvous) function is enabled.

stopped The supplicant is terminating.

success key received The supplicant received the EAP-Success key.

success but invalid key The supplicant received a message reporting that
EAP authentication was successful, but the EAPOL
key was invalid.

Terminated. The bonjour (rendezvous) function is disabled.
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Message Problem and solutions

There is problem in dhcp server operation. There is a problem with the DHCP server.

If multiple DHCP servers are active on the
network, check that they are assigning unique IP
addresses to each machine.

trap account is unavailable. v3Trap cannot be sent. This could be because the
Trap destination account is different from the
account specified by the printer.

unauthenticated The authentication failed. The supplicant was
denied access to the access point, or was not
authenticated.

waiting for keys The supplicant is waiting for the session key.

WPA supplicant started The WPA supplicant has started.

WPA supplicant unbound The WPA supplicant is not connected to the
unbound access point.

WS-Device started. WS-Device has started.

WS-Printer started. WS-Printer has started.

• For details about UNIX commands and parameters, see UNIX Supplement.
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3. Special Operations under Windows

Printing Files Directly from Windows
You can print files directly using Windows commands. For example, you can print PostScript files for
PostScript 3.

Windows 2000/XP/Vista, Windows Server 2003/2003 R2

You can print files directly using lpr, rcp ftp or sftp command.

Setup

Follow the procedure below to make network environment settings.

1. Enable TCP/IP with the control panel, and then set up the printer's network environment
about TCP/IP including IP addresses.

TCP/IP of the printer is set as default.

2. Install a TCP/IP in Windows to set up the network environment.

Consult the network administrator for the local setting information.

3. To print under Windows 2000/XP/Vista, Windows Server 2003/2003 R2, install
"Printing service for UNIX" as the network application.

• p.133 "Using DHCP"

Using a Host Name Instead of an IPv4 Address

When a host name is defined, you can specify a printer by host name instead of IP address. The host
names vary depending on the network environment.

When using DNS

Use the host name set to the data file on the DNS server.

When setting the IPv4 address of a printer using DHCP

Use the printer name on the configuration page as the host name.
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• For details about printing a configuration page, see "Printing the Configuration Page", General
Setting Guide.

In other cases

Add the IP address and host name of the network printer to the hosts file on the computer used for
printing. Methods of addition vary depending on operating systems.

Windows 2000/XP/Vista, Windows Server 2003/2003 R2

1. Open the hosts file using memo pad files, for instance.

The hosts file is in the following folder:

\WINNT\SYSTEM32\DRIVERS\ETC\HOSTS

"\WINNT" is the directory of the installation destination for Windows 2000/XP, and Windows
Server 2003/2003 R2.

2. Add an IPv4 or IPv6address and host name to the hosts file using the following format:

192.168.15.16 host # NP

"192.168.15.16" is the IPv4 address, "host" is the printer's host name, and "#NP" is replaced by
comments. Insert a space or tab between "192.168.15.16" and "host", between "host" and "#NP"
respectively, using one line for this format.

2001:DB::100 host # NP

"2001:DB::100" is the IPv6 address, "host" is the printer's host name, and "#NP" is replaced by
comments. Insert a space or tab between "2001:DB::100" and "host", between "host" and "#NP"
respectively, using one line for this format.

3. Save the file.

• When using a host name under Windows Server 2003/2003 R2 with IPv6 protocol, perform host
name resolution using an exrernal DNS server. The host file cannot be used.

Printing Commands

The following explains printing operations using the "lpr", "rcp", "ftp" and "sftp" commands.

Enter commands using the command prompt window. The location of the command prompts varies
depending on operating systems:

• Windows 2000

[Start] - [Programs] - [Accessories] - [Command Prompt]

3. Special Operations under Windows
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• Windows XP, Windows Vista, Windows Server 2003/2003 R2

[Start] - [All Programs] - [Accessories] - [Command Prompt]

• Match the data format of the file to be printed with the emulation mode of the printer.

• If the message "print requests full" appears, no print jobs can be accepted. Try again when sessions
end. For each command, the amount of possible sessions is indicated as follows:

• lpr: 5(When the spool printing function is available: 10)

• rcp, rsh: 5

• ftp: 3

• sftp: 3

• Enter the file name in a format including the path from the directory executing commands.

• The "option" specified in a command is an intrinsic printer option and its syntax is similar to printing
from UNIX. For details, see UNIX Supplement.

lpr

When specifying a printer by IP address

c:> lpr –S(printer's IP address) [-P(option)] [-ol] \(pass name)\(file name)

When using a host name instead of an IP address

c:> lpr –S(printer's host name) [-P(option)] [-ol] \(pass name)\(file name)

When printing a binary file, add the "-ol" option (lowercase O, and lowercase L).

When using a printer with the host name "host" to print a PostScript file named "file 1" located in the "C:
\PRINT" directory, the command line is as follows:

c:> lpr -Shost -Pfiletype=RPS -ol C:\PRINT\file1

rcp

First, register the printer's host name in the hosts file.

c:> rcp [-b] \(pass name)\(file name) [(pass name)\(file name)...] (printer's host

name):[option]

In file names, "*" and "?" can be used as wild cards.

When printing a binary file, add the "-b" option.

When using a printer with the host name "host" to print a PostScript file named "file 1" or "file 2" located
in the "C:\PRINT" directory, the command line is as follows:

c:> rcp -b C:\PRINT\file1 C:\PRINT\file2 host:filetype=RPS

Printing Files Directly from Windows

127



• p.125 "Using a Host Name Instead of an IPv4 Address"

ftp / sftp

Use the "put" or "mput" command according to the number of files to be printed.

When one file is printed

ftp> put \(pass name)\(file name) [option]

When multiple files are printed

ftp> mput \(pass name)\(file name) [\(pass name)\(file name)...] [option]

Follow the procedure below to print using the "ftp" command.

1. Formulate the printer's IP address or the host name of the hosts file printer as an argument
and use the "ftp" command.

% ftp "printer's IP address"

2. Enter the user name and password, and then press the [Enter] key.

For details about the user name and password, consult your network administrator.

User:

Password:

When user authentication is set, enter a login user name and password.

3. When printing a binary file, set the file mode to binary.

ftp> bin

When printing a binary file in ASCII mode, print may not come out correctly.

4. Specify files to be printed.

The following shows the examples of printing a PostScript file named "file 1" in the "C:\PRINT"
directory and printing file 1 and file 2.

ftp> put C:\PRINT\file1 filetype=RPS

ftp> mput C:\PRINT\file1 C:\PRINT\file2

5. Quit ftp.

ftp> bye

• "=", ",", "_", and ";" cannot be used for filenames. File names will be read as option strings.

• If you are using ftp, you cannot specify an option using the "mput" command.

• If you are using ftp, you cannot specify an option using the "pwd" command.

• If you are using sftp, you cannot specify an option using the "cd" command.
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• If you are using sftp, you cannot specify an option using the "pwd" command.

• If personal authentication (Basic, Windows, LDAP, or Integrated Server Authentication) is enabled,
only authenticated users (users authenticated by login user name and password) can log on.

• For "mput" command, "*" and "?" can be used as wild cards in file names.

• When printing a binary file in ASCII mode, print may not come out correctly.

• For details about registering the machine's host name to the host file, see "Using a Host Name
Instead of an IPv4 Address".

• For details about login user name and password, see Security Reference, which is the
administrator's manual.
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4. Appendix

When Using Windows Terminal Service/
MetaFrame
The following explains how to use Windows Terminal Service and Maintenance.

Operating Environment

The following operating systems and MetaFrame versions are supported.

Windows 2000 Server / Advanced Server

• MetaFrame 1.8 SP3 / FR1+SP3 / SP4 / FR1+SP4

• MetaFrame XP 1.0 SP1 / SP2 / FR1 / FR1+SP2 / FR2 / SP3 / FR2+SP3 / FR3

• MetaFrame Presentation Server 3.0

• Citrix Presentation Server 4.0

Windows 2003 Server

• MetaFrame XP 1.0 FR3

• MetaFrame Presentation Server 3.0

• Citrix Presentation Server 4.0

Supported Printer Drivers

When Windows Terminal Service is operating

• PostScript 3

• RPCS drivers

• Some RPCS printer driver functions do not work if Windows Terminal Service is installed.

Limitations

The following limitations apply to the Windows Terminal Service environment.

These limitations are built in Windows Terminal Service or MetaFrame.
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Windows Terminal Service

In the Windows Terminal Service environment, some of the printer driver's functions is unavailable.
In an environment where Windows Terminal Service is installed, some of the printer driver's
functions is unavailable, even if any function of Windows Terminal Service is not used. When you
install SmartDeviceMonitor for Client in an environment where the Terminal Service is running on a
Windows NT Server 4.0 Terminal Server Edition or the Windows 2000 Server family computer, be
sure to install it using the install mode. The following are the two methods of installation using the
install mode:

1. Use [Add/Remove Programs] in [Control Panel] to install SmartDeviceMonitor for Client.

2. Enter the following command in the MS-DOS command prompt:

To quit the install mode, enter the following command in the MS-DOS command prompt.

MetaFrame's [Auto-creating client printers]

Using [Auto-creating client printers] can select a logical printer created by copying the client's local
printer data to the MetaFrame server. We strongly recommend testing this function in your network
environment before using it for your work.

• The settings for optional equipment will not be stored in the server after the equipment is
disconnected. The settings for optional equipment will be restored to its defaults each time the
client computer logs on to the server.

• When printing a large number of bitmap images or using the server in a WAN environment
over dial-up lines such as ISDN, printing may not be possible or errors may occur, depending
on data transfer rates.

• When using MetaFrame XP 1.0 or higher versions, we recommend making settings in [Client
Printer bandwidth] under [Citrix Management Console] according to the environment.

• If a print error occurs on the server and the print job or a printer created in [Auto-creating
client printers] cannot be deleted, we recommend the following:

• MetaFrame 1.8 SP3, MetaFrame XP 1.0 SP1/FR1

Make settings in [Delete unfinished print jobs] in the registry. For details, see the Readme
file provided with MetaFrame.

• MetaFrame XP 1.0 FR2

Make settings in [Delete pending print jobs at logout] under [Printer Properties
Management] of Citrix Management Console.

MetaFrame's [Printer driver replication]

Using [Printer driver replication] can distribute printer drivers across all servers in a server farm. We
strongly recommend testing this function in your network environment before using it for your work.

• If the printer drivers are not properly copied, install them directly onto each server.
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Using DHCP
You can use the printer in a DHCP environment. You can also register the printer NetBIOS name on a
WINS server when it is running.

• Printers that register the printer NetBIOS name on a WINS server must be configured for the WINS
server.

• Supported DHCP servers are Microsoft DHCP Server included with Windows 2000 Server, and
Windows Server 2003/2003 R2, and the DHCP server included with NetWare and UNIX.

• If you do not use the WINS server, reserve the printer's IP address in the DHCP server so the same
IP address is assigned every time.

• To use the WINS server, change the WINS server setting to “active” using the control panel.

• Using the WINS server, you can configure the host name via the remote network printer port.

• DHCP relay-agent is not supported. If you use DHCP relay-agent on a network via ISDN, it will
result in increased line charges. This is because your computer connects to the ISDN line whenever
a packet is transferred from the printer.

• If there is more than one DHCP server, use the same setting for all servers. The machine operates
using data from the DHCP server that responds first.

• DHCP servers can operate in an IPv6 environment, but they cannot be configured to allocate IPv6
addresses or obtain host names.

Using AutoNet

If the printer IPv4 address is not automatically assigned by the DHCP server, a temporary IP address
starting with 169.254 and not used on the network can be automatically selected by the printer.

• The IP address assigned by the DHCP server is given priority over that selected by AutoNet.

• You can confirm the current IPv4 address on the configuration page. For more information about
the configuration page, see General Settings Guide.

• When AutoNet is running, the NetBIOS name is not registered on the WINS server.

• The machine cannot communicate with devices that do not have the AutoNet function. However,
this machine can communicate with Macintosh computers running Mac OS X 10.2.3. or higher.

Using DHCP
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Configuring the WINS Server
The printer can be configured to register its NetBIOS name with a WINS server when the power is
turned on. This enables the NetBIOS name of the printer to be specified from SmartDeviceMonitor for
Admin even in a DHCP environment.

This section explains configuring the WINS server.

• The WINS server is supported with Windows 2000 Servers WINS Manager.

• For details about the WINS server settings, see Windows Help.

• If there is no reply from the WINS server, the NetBIOS name is registered by broadcast.

• The NetBIOS name can be entered using up to 13 alphanumeric characters.

Using Web Image Monitor

1. Start a Web browser.

2. Enter “http://(machine's IP address or host name) /” in the address bar to access the
printer whose settings you want to change.

Top Page of Web Image Monitor appears.

3. Click [Login].

The dialog box for entering the user name and password appears.

4. Enter the user name and password, and then click [Login].

Contact your administrator for information about the settings.

5. In the left area, click [Configuration], and then click [Network].

6. Click [TCP/IP].

7. Check that [Enable] is selected for [WINS] in the [Ethernet + Wireless LAN] column, and
then enter the WINS server IPv4 address in [Primary WINS Server] and [Secondary
WINS Server].

8. Click [Apply].

9. Quit Web Image Monitor.

Using telnet

You can also use telnet to configure WINS.
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Using the Dynamic DNS Function
Dynamic DNS is a function which dynamically updates (registers and deletes) records (A record, AAAA
record, CNAME, and PTR record) managed by the DNS server. When a DNS server is part of the
network environment to which this printer, a DNS client, is connected, records can be dynamically
updated using this function.

Updating

Updating procedure varies depending on whether the printer IP address is static or acquired by DHCP.

• Dynamic update using message authentication (TSIG, SIG(0)) is not supported.

For a static IPv4 setting

If the IP address or host name is changed, the A and PTR records are updated. If the A record is
registered, CNAME is also registered. CNAMEs that can be registered are as follows:

• Ethernet and IEEE 802.11

RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the MAC address)

However, if CNAME (PRNXXXXXX) overlaps with the host name, CNAME will not be
registered.

For DHCPv4 settings

As a substitute for the printer, the DHCP server updates the record, and one of the following occurs:

• When the printer acquires the IP address from the DHCP server, the DHCP server updates the
A and PTR records.

• When the printer acquires the IP address from the DHCP server, the printer updates the A
record, and the DHCP server updates the PTR record.

If the A record is registered, CNAME is also registered. CNAMEs that can be registered are as
follows:

• Ethernet and IEEE 802.11

RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the MAC address)

For IPv6 settings

This machine updates the AAAA record and PTR record.

It also updates CNAME when the AAAA record is updated.

When a stateless address is newly set, it is automatically registered on the DNS server also.

Using the Dynamic DNS Function
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• When the dynamic DNS function is not used, records managed by the DNS server must be
updated manually, if the printer's IP address is changed.

• To update the record using the printer, the DNS server has to have one of the following:

• No security settings made.

• If security settings are made, an IP-specified client (this printer) permits updating.

DNS servers targeted for operation

For static IP setting

• Microsoft DNS servers with standard Windows 2000 Server, and Windows Server
2003/2003 R2 features

• BIND 8.2.3 or higher

For DHCP setup, when the printer updates the A record

• Microsoft DNS servers with standard Windows 2000 Server, and Windows Server
2003/2003 R2 features

• Microsoft DNS servers with standard Windows 2000 Server, and Windows Server
2003/2003 R2 features

For DHCP setup, when the DHCP server updates records

• Microsoft DNS servers with standard Windows 2000 Server, and Windows Server
2003/2003 R2 features

• BIND 8.2.3 or higher

• DNS servers with standard NetWare 5 (or a higher version) features

For IPv6 setting

• Microsoft DNS servers with standard Windows Server 2003/2003 R2 features

• BIND 9.2.3 or higher

DHCP servers targeted for operation

As a substitute for the printer, DHCP servers capable of updating the A record and PTR record are as
follows:

• Microsoft DHCP servers with standard Windows 2000 Server (Service Pack 3 or higher versions),
or Windows Server 2003/2003 R2 features

• ISC DHCP 3.0 or higher

• DHCP server with standard NetWare 5 features
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Setting the dynamic DNS function

Make settings with telnet using the “dns” command.

• For details, see “Remote Maintenance by telnet”.

• p.59 "Remote Maintenance by telnet"
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Precautions
Please pay attention to the following when using the network interface board. When configuration is
necessary, follow the appropriate procedures below.

Connecting a Dial-Up Router to a Network

When using NetWare (file server)

If the NetWare file server and printer are on opposite sides of a router, packets are sent back and forth
continuously, possibly incurring communications charges. Because packet transmission is a feature of
NetWare, you need to change the configuration of the router. If the network you are using does not
allow you to configure the router, configure the machine instead.

Configuring the router

Filter packets so they do not pass over the dial-up router.

• The MAC address of the filtering printer is printed on the printer configuration page. For more
information about printing a configuration page, see "Printing the Configuration Page",
General Settings Guide.

• For more information about configuring the printer if the router cannot be configured, see the
following instructions.

Configuring the printer with NetWare

1. Following the setup method described earlier in this manual, configure the file server.

2. Set the frame type for NetWare environment.

• For more information about selecting a frame type, see "Interface Settings", General Settings
Guide.

Configuring the printer without NetWare

1. When not printing, the network interface board sends packets over the network. Set
NetWare to "inactive".

• For more information about selecting a protocol, see "Interface Settings", General Settings Guide.
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When Using Network Utility

If the machine is connected to a network, observe the following points when setting up the machine or
changing settings:

For more details, see the operating instructions and Help for the ScanRouter delivery software and
DeskTopBinder.

When a dial-up router is connected in a network environment

The settings for the delivery server to be connected must be made appropriately for the machine
with the ScanRouter delivery software, Auto Document Link, or DeskTopBinder. In addition, set up
connected devices using the I/O settings of the ScanRouter delivery software administration utility.

If the network environment changes, make the necessary changes for the delivery server using the
machine, the administration utility of client computers, Auto Document Link, and DeskTopBinder.
Also, set the correct information for the connected devices using the I/O settings of the ScanRouter
delivery software administration utility.

• If the machine is set up to connect to the delivery server via a dial-up router, the router will dial
and go online whenever a connection to the delivery server is made. Telephone charges may
be incurred.

When connected to a computer that uses dial-up access

• Do not install the ScanRouter delivery software on a computer which uses dial-up access.

• When using the ScanRouter delivery software, DeskTopBinder, Auto Document Link, or a
TWAIN driver on a computer with dial-up access, a dial-up connection may be performed
when connecting to the delivery server and other equipment, depending on the setup. If the
computer is set up to connect to the Internet automatically, the confirmation dialog box will not
appear, and telephone charges may be incurred without your being aware of it. To prevent
unnecessary connections, the computer should be set up so the confirmation dialog box
always appears before establishing a connection. Do not make unnecessary connections
when using the above listed software.

NetWare Printing

• IPv6 cannot be used on this function.

Form feed

You should not configure form feed on NetWare. Form feed is controlled by the printer driver on
Windows. If NetWare form feed is configured, the printer might not work properly. If you want to
change form feed settings, always configure them using Windows.
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• Under Windows 2000/XP and Windows Server 2003/2003 R2, clear the [Form feed] check
box on the [NetWare Settings] tab in the printer properties dialog box.

Banner page

You should not configure a banner page on NetWare. If you want to change the banner page setting,
always configure it using Windows.

• Under Windows 2000/XP and Windows Server 2003/2003 R2, clear the [Enable banner]
check box on the [NetWare Settings] tab in the printer properties dialog box.

Printing after resetting the machine

After resetting the remote printer, the connection from the print server will be cut off for about 30-40
seconds before re-connecting. Depending on the NetWare specification, print jobs may be accepted,
but they will not be printed during this interval.

When using the machine as a remote printer, wait about two minutes after resetting before attempting to
print.

When the IEEE 802.11 interface unit is installed

When using the wireless LAN interface on the network, note the following:

If the network area provides poor radio environment

Where radio wave conditions are bad, the network may not function due to interrupted or failed
connections. When checking the wireless LAN signal and the access point, follow the procedure
below to improve the situation:

• Position the access point nearer to the machine.

• Clear the space between access point and machine of obstructions.

• Move radio wave generating appliances, such as microwaves, away from the machine and
access point.

• For information about how to check radio wave status, see "Checking the Signal", General Settings
Guide.

• For more information about access point radio wave conditions, refer to the access point manual.

Configuring WPA/WPA2

WPA/WPA2 uses an authentication server to provide greatly enhanced security compared to WPA-
PSK/WPA2-PSK.
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WPA/WPA2 can be configured using Web Image Monitor's administrator mode. You can select four
types of EAP authentication method: EAP-TLS, LEAP, EAPTTLS and PEAP. Note that each EAP
authentication method has different configuration settings and authentication procedures.

Types and requirements of certificates are as follows:

If a certificate is required, configure all settings after installing the certificate.

EAP Types Requiring a "Site Certificate"

EAP-TLS, EAP-TTLS, PEAP (Necessary except LEAP)

EAP Types Requiring a "Site Certificate" and a "Device Certificate"

EAP-TLS, PEAP (Phase 2 is for TLS only)

• To set WPA/WPA2, you must enable SSL. If you do not use SSL, security problems may occur. For
details about setting SSL configuration, see "Protection Using Encryption", Security Reference.

• To set WPA/WPA2, you must use Web Image Monitor.

Installing a Site Certificate

1. Access the authentication server and obtain the CA certificate.

Methods of obtaining certificates differ according to the operating system you are using.

2. Log on to Web Image Monitor in the administrator mode.

3. Click [Configuration].

4. [Site Certificate] in the "Security" area.

5. Click [Browse] on the "Site Certificate to Import" window, and then select the CA
certificate you obtained.

6. Click [Import].

7. Check that the imported certificate's [Status] shows "Trustworthy".

If [Site Certificate Check] shows "Active", and the [Status] of the certificate shows "Untrustworthy",
communication might not be possible.

8. Click [OK].

9. Click [Logout].

10. Quit the Web Image Monitor.

Installing Device Certificate

1. Log on to Web Image Monitor in the administrator mode.

2. Click [Configuration].
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3. Click [Device Certificate] in "Security" area.

4. Click [Certificate 2] on the "Device Certificate" window, and then click [Request].

5. Enter appropriate "Common Name" and "Country Code" on "Certificate Information"
page, and then click [OK].

6. "Updating..." appears. Wait for about 2 minutes, and then click [OK].

7. Click [Details], shown in the "Device Certificate" window as the memo pad icon for
"Requesting".

8. Select all, and then copy the entire "Text for Requested Certificate" text that is displayed
in the "Certificate Status" window.

9. Access the certificate authority server, and then obtain the CA signified certificate using
the text copied into "Text for Requested Certificate" windows.

Obtaining the certificate differs depending on the environment you want to use.

10. Click [Certificate 2] on "Device Certificate" window, and then click [Install].

11. Using a text editor, open the CA signified certificate downloaded in step 11, and then
copy over all the text.

12. In the [Install Certificate] window, paste all the text copied into the CA signified certificate.

13. Click [OK].

14. "Updating..." appears. Wait for about one or two minutes, and then click [OK].

15. Check that the "Device Certificate" shows "Installed".

16. Click [Certificate 2] on "Certification", and then click [OK].

17. Click [Logout].

18. Quit Web Image Monitor.

• you request two certificates simultaneously, the certificate authority might not display either
certificate. Click [Cancel Request] to cancel the request.

• You can select [Certificate 1] and [Certificate 2] in the "Device Certificate" window. Note that if
you select [Certificate 1] in the "Device Certificate" window, you must select [Certificate 1] in the
"IEEE 802.11a" drop down menu in the "Certification" window.

• Click [Cancel Request] to cancel the request for the server certificate.

• If "Not found" appears after clicking [OK] in steps 8 and 16, wait one or two minutes, and then
click [Refresh].

Setting Items of WPA/WPA2

1. Log on to Web Image Monitor in the administrator mode.

2. Click [Configuration], and then click [Wireless LAN Settings] in the "Interface" area.
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3. Select [Infrastructure Mode] in "Communication Mode".

4. Enter the alphanumeric characters (a-z, A-Z, or 0-9) in [SSID] according to the access
point you want to use.

5. Select [WPA] in "Security Method".

6. Select [TKIP] or [CCMP (AES)] in "WPA Encryption Method" according to the access point
you want to use.

7. Select [WPA] or [WPA2] in "WPA Authentication Method".

8. In "User Name", enter the user name set in the RADIUS server.

9. Enter the domain name in "Domain Name".

10. Select "EAP Type". Configurations differ according to the EAP Type.

EAP-TLS

• Make the following settings according to the operating system you are using:

• Select [On] or [Off] in "Authenticate Server Certificate".

• Select [On] or [Off] in "Trust Intermediate Certificate Authority".

• Enter the host name of the RADIUS server on "Server ID".

LEAP

• Click [Change] in "Password", and then enter the password set in the RADIUS server.

EAP-TTLS

• Click [Change] in "Password", and then enter the password set in the RADIUS server.

• Click [Change] in "Phase 2 User Name", and then enter the user name set in the RADIUS
server.

• Select [CHAP], [MSCHAP], [MSCHAPv2], [PAP], or [MD5] in "Phase 2 Method".

• Certain methods might not be available, depending on the RADIUS server you want to use.

• Make the following settings according to the operating system you are using:

• Select [On] or [Off] in "Authenticate Server Certificate".

• Select [On] or [Off] in "Trust Intermediate Certificate Authority".

• Enter the host name of the RADIUS server in "Server ID".

PEAP

• Click [Change] in "Password", and then enter the password set in the RADIUS server.

• Click [Change] on "Phase 2 User Name", and then enter the user name set in the RADIUS
server.

• Select [MSCHAPv2] or [TLS] in "Phase 2 Method".

• When you select [TLS], select the client certificate you want to use in "WPA Client Certificate".

• Make the following settings according to the operating system you are using:
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• Select [On] or [Off] in "Authenticate Server Certificate".

• Select [On] or [Off] in "Trust Intermediate Certificate Authority".

• Enter the host name of the RADIUS server on "Server ID".

11. Click [OK].

12. Click [Logout].

13. Quit the Web Image Monitor.

• If there is a problem with settings, you might not be able to communicate with the printer. To identify
the problem, print a network summary.

• If you cannot identify the problem, reset the printer interface to normal, and then repeat the
procedure from the beginning.
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Setting Up the Machine on a Network
This section describes the network settings you can change with User Tools (System Settings). Make
settings according to functions you want to use and the interface to be connected.

• These settings should be made by the systems administrator, or after consulting with the systems
administrator.

Initial Settings Overview

Interface Settings

Menu Description

Machine IPv4 Address Specify the machine's IPv4 network address.

IPv4 Gateway Address Specify the gateway address for the router or
host computer used as a gateway.

Machine IPv6 Address Displays the machine's IPv6 network address.

IPv6 Gateway Address Displays the machine's IPv6 gateway address.

IPv6 Stateless Address Autoconfiguration Specify IPv6 Stateless Address
Autoconfiguration.

DNS Configuration Make settings for the DNS server.

DDNS Configuration Specifies the DDNS settings.

IPSec Specify the machine's IPSec function Active/
Inactive.

Domain Name Specifies the domain name.

WINS Configuration Specifies the WINS server settings.

Effective Protocol Select the protocol to use in the network.

NCP Delivery Protocol Select the protocol for NCP delivery:

NW Frame Type Select the frame type when you use NetWare.

SMB Computer Name Specify the SMB computer name.

SMB Work Group Specify the SMB work group.
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Menu Description

Ethernet Speed Set the access speed for networks.

LAN Type When you have installed the IEEE 802.11a/g
interface unit, select the method of connection.

Ping Command Check the network connection with ping
command using given IP address.

Permit SNMPv3 Communication Set the encrypted communication of SNMP v3.

Permit SSL / TLS Communication Set the encrypted communication of SSL/TLS.

Host Name Specify the host name.

Machine Name Specify the machine name.

Communication Mode Specifies the communication mode of the
wireless LAN.

SSID Setting Specifies SSID to distinguish the access point in
infrastructure mode or 802.11 ad hoc mode.

Ad-hoc Channel Specify the channel to use when [802.11 Ad-
hoc Mode] has been selected. Set the channel
that matches the type of wireless LAN being
used.

Security Method Specifies the encryption of the IEEE
802.11a/g (wireless LAN).

Wireless LAN Signal When using in infrastructure mode, you can
check the machine's radio wave status using
the control panel.

Restore Factory Defaults You can return the wireless LAN settings to
their defaults.

File Transfer Settings

Menu Description

Delivery Option
Enables or disables sending stored or scanned
documents to the ScanRouter delivery server.

Capture Server IPv4 Address Specify the capture server IPv4 address.
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Menu Description

SMTP Server Specifies the SMTP server name.

SMTP Authentication Specify SMTP authentication (PLAIN, LOGIN,
CRAMMD5, DIGEST-MD5).

POP before SMTP Specify POP authentication (POP before
SMTP).

Reception Protocol Specify Reception Protocol for receiving
Internet Fax.

POP3 / IMAP4 Settings Specify the POP3/IMAP4 server name for
receiving Internet faxes.

Administrator's E-mail Address Specify the Administrator's E-mail Address.

E-mail Communication Port Specify the port numbers for receiving Internet
faxes. The specified POP3 port number is used
for [POP before SMTP].

E-mail Reception Interval Specify, in minutes, the time interval for
receiving Internet faxes via POP3 or IMAP4
server.

Max. Reception E-mail Size Specify the maximum reception e-mail size for
receiving Internet faxes.

E-mail Storage in Server Specify whether or not to store received
Internet fax e-mails on the POP3 or IMAP4
server.

Default User Name / Password (Send) Specify the user name and password required
when sending scan files directly to a shared
folder on a computer running Windows, to an
FTP server, or to a NetWare server.

Program / Change / Delete E-mail Message You can program, change, or delete the e-mail
message used when sending an Internet fax or
scan file as an attachment.

Auto Specify Sender Name Set whether or not to specify the name of the
sender when sending e-mail.
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Menu Description

Scanner Resend Interval Time Specifies the interval the machine waits before
resending a scan file, if it cannot be sent to the
delivery server or mail server.

Number of Scanner Resends Sets a maximum number of times a scan file is
resent to the delivery server or mail server.
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Initial Settings

Printer

Interface Settings

Ethernet Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

Machine IPv6 Address

IPv6 Gateway Address

IPv6 Stateless Address
Autoconfiguration

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

NW Frame Type

SMB Computer Name

SMB Work Group

Ethernet Speed

LAN Type

Permit SNMPv3
Communication

Permit SSL/TLS
Communication

Host Name

Machine Name
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Interface Settings

Wireless LAN Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

Machine IPv6 Address

IPv6 Gateway Address

IPv6 Stateless Address
Autoconfiguration

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

NW Frame Type

SMB Computer Name

SMB Work Group

LAN Type

Permit SNMPv3
Communication

Permit SSL/TLS
Communication

Host Name

Machine Name

Interface Settings/ Wireless
LAN

Communication Mode

SSID Setting

Channel

Security Method
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E-mail

Interface Settings

Ethernet Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

Ethernet Speed

LAN Type

Permit SNMPv3
Communication

Permit SSL/TLS
Communication

Host Name

File Transfer SMTP Server

SMTP Authentication

POP before SMTP

Reception Protocol

POP3 / IMAP4 Settings

Administrator's E-mail Address

E-mail Communication Port

Program / Change / Delete
E-mail Message

Scanner Resend Interval Time

Number of Scanner Resends
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Interface Settings

Wireless LAN Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

LAN Type

Permit SNMPv3
Communication

Permit SSL/TLS
Communication

Host Name

Interface Settings/ Wireless
LAN

Communication Mode

SSID Setting

Channel

Security Method

File Transfer SMTP Server

SMTP Authentication

POP before SMTP

Reception Protocol

POP3 / IMAP4 Settings

Administrator's E-mail Address

E-mail Communication Port

Program / Change / Delete
E-mail Message

Scanner Resend Interval Time

Number of Scanner Resends
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Scan to Folder

Interface Settings

Ethernet Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

Ethernet Speed

LAN Type

Permit SNMPv3
Communication

Permit SSL/TLS
Communication

Host Name

File Transfer Scanner Resend Interval Time

Number of Scanner Resends
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Interface Settings

Wireless LAN Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

LAN Type

Permit SNMPv3
Communication

Permit SSL/TLS
Communication

Host Name

Interface Settings/ Wireless
LAN

Communication Mode

SSID Setting

Channel

Security Method

File Transfer Scanner Resend Interval Time

Number of Scanner Resends
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Network Delivery Scanner

Interface Settings

Ethernet Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

Ethernet Speed

LAN Type

Permit SNMPv3
Communication

Permit SSL/TLS
Communication

Host Name

File Transfer Delivery Option

Scanner Resend Interval Time

Number of Scanner Resends
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Interface Settings

Wireless LAN Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

LAN Type

Permit SNMPv3
Communication

Permit SSL/TLS
Communication

Host Name

Interface Settings/ Wireless
LAN

Communication Mode

SSID Setting

Channel

Security Method

File Transfer Delivery Option

Scanner Resend Interval Time

Number of Scanner Resends
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Network TWAIN Scanner

Interface Settings

Ethernet Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

Ethernet Speed

LAN Type

Permit SNMPv3
Communication

Permit SSL/TLS
Communication

Host Name
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Interface Settings

Wireless LAN Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

LAN Type

Permit SNMPv3
Communication

Permit SSL/TLS
Communication

Host Name

Interface Settings/ Wireless
LAN

Communication Mode

SSID Setting

Channel

Security Method
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Document Server

Interface Settings

Ethernet Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

Machine IPv6 Address

IPv6 Gateway Address

IPv6 Stateless Address

Autoconfiguration

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

Ethernet Speed

LAN Type

Permit SNMPv3
Communication

Permit SSL/TLS
Communication

Host Name
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Interface Settings

Wireless LAN Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

Machine IPv6 Address

IPv6 Gateway Address

IPv6 Stateless
Autocofiguration

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

LAN Type

Permit SNMPv3
Communication

Permit SSL/TLS
Communication

Host Name

Interface Settings/ Wireless
LAN

Communication Mode

SSID Setting

Channel

Security Method

Transmission Speed

• For the Effective Protocol setting, check that the protocol you want to use is set to [Active].

• [Wireless LAN] and [LAN Type] are displayed when the wireless LAN interface board is installed.

• When both Ethernet and wireless LAN are connected, the selected interface takes precedence.
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• SMTP Server and Fax E-mail Account must be specified in order to send Internet Fax.

• When [POP before SMTP] is set to [On], you must also make settings for [Reception Protocol] and
[POP3 / IMAP4 Settings].

• When [SMTP Authentication] is set to [On], you must also make settings for [Administrator's E-mail
Address].

• When setting [POP before SMTP] to [On], check POP3 port number in [E-mail Communication
Port].

• If [Delivery Option] is set to [On], check that IPv4 Address is specified.
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Specifications
Interface 1000BASE-T, 100BASE-TX, 10BASE-T, IEEE

802.11a/b/g

Frame type EthernetII, IEEE 802.2, IEEE 802.3, SNAP

Printer IPv4/IPv6

LPR

RSH

RCP

DIPRINT

FTP

IPP

IPP-SSL

IPX/SPX (NetWare)

AppleTalk

SMB

WS-Printer

Network Scanner IPv4/IPv6

RSH

FTP

FTP-C

SMTP

SMTP-C

POP3

SMB

NCP
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Document Server IPv4/IPv6

FTP

FTP-C

HTTP

HTTPS

Management Function IPv4/IPv6

RSH

RCP

FTP

FTP-C

SNMP

SNMP-C

HTTP

HTTPS

TELNET (mshell)

NBT

DHCP

DNS

DNS-C

LDAP

SNMP v1/v2 MIB-II, PrinterMIB, HostResourceMIB, IPv6-TCP-
MIB, IPv6-UDP-MIB, IPv6-MIB, IPv6-ICMP-MIB,
RicohPrivateMIB
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SNMP v3 MIB-II, PrinterMIB, HostResourceMIB,
RicohPrivateMIB, SNMP-FRAMEWORK-MIB,
SNMP-TARGET-MIB, SNMP-NOTIFICATION-
MIB, SNMP-USER-BASED-SM-MIB, SNMP-
VIEW-BASED-ACM-MIB, IPv6-TCP-MIB, IPv6-
UDP-MIB, IPv6-MIB, IPv6-ICMP-MIB

To use IPP and SMB, use the SmartDeviceMonitor for Client port.

To use IPP under Windows XP, Windows Server 2003, use the Standard IPP port. To use IPP under
Windows 98, Windows 2000, Windows NT, use SmartDeviceMonitor for Client.

AppleTalk can be used when the PostScript 3 module is installed.

Under Window Vista, WS-Printer uses the WSD Port.

Functions

The following functions are available with the machine:

• Copy

• Printer

• Scanner

• Document Server

• The machine must be equipped with the Printer/Scanner Unit in order to use the printer or scanner
function.
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Software Version Conventions Used in This Manual

* NetWare 3.x means NetWare 3.12 and 3.2.

* NetWare 4.x means NetWare 4.1, 4.11, 4.2 and IntranetWare.

Trademarks

Microsoft®, Windows®, Windows Server®, Windows Vista®, and Internet Explorer® are either registered trademarks 

or trademarks of Microsoft Corporation in the United States and/or other countries.

Adobe, Acrobat, PostScript are either registered trademarks or trademarks of Adobe Systems Incorporated in the 

United States and/or other countries.

Apple, AppleTalk, Bonjour, Macintosh, and Mac OS are registered trademarks of Apple Inc, registered in the United 

States and other countries.

UNIX is a registered trademark of The Open Group.

Netware,IPX,IPX/SPX are either registered trademarks or trademarks of Novell, Inc.

Other product names used herein are for identification purposes only and might be trademarks of their respective 

companies. We disclaim any and all rights to those marks.

The proper names of Internet Explorer 5.5 and 6 are as follows:

*  Microsoft® Internet Explorer® 5.5

*  Microsoft® Internet Explorer® 6

The proper names of the Windows operating systems are as follows:

*  The product names of Windows 2000 are as follows:

Microsoft® Windows® 2000 Professional

Microsoft® Windows® 2000 Server

Microsoft® Windows® 2000 Advanced Server

*  The product names of Windows XP are as follows:

Microsoft® Windows® XP Professional

Microsoft® Windows® XP Home Edition

Microsoft® Windows® XP Media Center Edition

Microsoft® Windows® XP Tablet PC Edition

*  The product names of Windows Vista are as follows:

Microsoft® Windows Vista® Ultimate

Microsoft® Windows Vista® Business

Microsoft® Windows Vista® Home Premium

Microsoft® Windows Vista® Home Basic

Microsoft® Windows Vista® Enterprise

*  The product names of Windows Server 2003 are as follows:

Microsoft® Windows Server® 2003 Standard Edition

Microsoft® Windows Server® 2003 Enterprise Edition

Microsoft® Windows Server® 2003 Web Edition

Microsoft® Windows Server® 2003 Datacenter Edition

*  The product names of Windows Server 2003 R2 are as follows:

Microsoft® Windows Server® 2003 R2 Standard Edition

Microsoft® Windows Server® 2003 R2 Enterprise Edition

Microsoft® Windows Server® 2003 R2 Datacenter Edition
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